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Preface

Purpose

This document describes the procedure for upgrading a Cisco ICM/IP Contact Center Enterprise
Edition, Release 5.0(0) or a Cisco ICM/IP Contact Center Enterprise Edition, Release 6.0(0)
system to a Cisco ICM/IP Contact Center Enterprise Edition, Release 7.0(0) system. This
document further addresses the acceptable component release compatibilities as well as their
operating system and database server releases. A baseline for start of upgrade to ICM 7.0 is
defined in this document and further addresses the acceptable component version compatibilities
that are allowed during and after the upgrade process is complete.

Audience

This document is intended for both Customer and Cisco representatives (trained in Cisco ICM
software system administration and troubleshooting) performing a system upgrade.

This document assumes that as a member of the Upgrade Team you meet the following skill
set requirements:

• Familiar with Windows Operating System

– Active Directory

– Security concepts

– Network configuration and operation

• Familiar with SQL Server

– Enterprise Manager
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– Query Analyzer

– SQL scripting

• ICM/IPCC knowledge

– ICM/IPCC Nodes (CallRouter, Logger, AW, PGs)

– HDS Schema knowledge

– Deployment models (including WebView)

– Have read the Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System
Software Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/
custcosw/ps1001/products_user_guide_list.html) and Cisco IP Contact Center Enterprise
Edition Releases 5.0 and 6.0 Solution Reference Network Design (SRND)  (http://
www.cisco.com/en/US/products/sw/custcosw/ps1844/
products_implementation_design_guide_book09186a00803fb6ac.html).

Organization

Related Documentation

Conventions

This manual uses the following conventions:

DescriptionConvention

Boldface font is used to indicate commands,
such as user entries, keys, buttons, and folder
and submenu names. For example:

boldface font

• Choose Edit > Find.

• Click Finish.
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DescriptionConvention

Italic font is used to indicate the following:italic font

• To introduce a new term. Example: A skill
group is a collection of agents who share
similar skills.

• For emphasis. Example: Do not use the
numerical naming convention.

• A syntax value that the user must replace.
Example: IF (condition, true-value,
false-value)

• A book title. Example: See the Cisco CRS
Installation Guide.

Window font, such as Courier, is used for the
following:

window font

• Text as it appears in code or that the window
displays. Example: <html><title>Cisco
Systems,Inc. </title></html>

Angle brackets are used to indicate the
following:

< >

• For arguments where the context does not
allow italic, such as ASCII output.

• A character string that the user enters but
that does not appear on the window such as
a password.

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering
additional information, see the monthly What's New in Cisco Product Documentation, which
also lists all new and revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication
(RSS) feed and set content to be delivered directly to your desktop using a reader application.
The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
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Documentation Feedback

You can provide comments about this document by sending email to the following address:

mailto:ccbu_docfeedback@cisco.com

We appreciate your comments.
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ICM/IPCC Upgrade Planning

Upgrade Planning

When planning to upgrade your ICM/IPCC system, first prepare these items:

• Pre-upgrade testing

• Network inventory

• Data backup plan

• Network configuration backup

• Default routing plan

• Test plan

• Detailed schedule of upgrade activities

• Definition of upgrade steps

• Post-upgrade test definition

• Stakeholder notification

It is necessary to consider the additional software that interfaces with the Cisco ICM software
when planning your ICM/IPCC upgrade.
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Examples of the additional software include:

• IPCC including CallManager and IP IVR

• CTI desktop/client

• Unity

• Personal Assistant

• Auto Attendant

• Recording solutions

Hardware Requirements

The ICM system hardware (that is, hard drive(s), memory, etc.) must meet certain requirements
to run ICM software release.

Hardware specifications play a critical part in the successful operation of an ICM system. Audit
all servers prior to the upgrade to determine if a hardware upgrade is required.

First, review the ICM 7.0(0) hardware and software specifications. The minimum hardware
requirements to upgrade to ICM software Release 7.0(0) are found in the Cisco ICM/IPCC
Enterprise and Hosted Edition Hardware and System Software Specification (Bill of
Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
products_user_guide_list.html).

Pre-upgrade Testing

At the beginning of the maintenance window create a pre-upgrade test plan to establish the
benchmark. This benchmark is used when you run the post-upgrade tests you develop to test
your ICM system during the various stages of the upgrade process.

The following are examples of typical ICM system pre-upgrade tests:

• Application test

• System integrity tests:

– Process testing

– Redundancy testing

– Alarm testing

– Historical reporting testing

– WebView reporting testing (option)

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)
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– Internet Script Editor testing (option)

Network Inventory

Technology Refresh upgrade migration planning and execution require you draw a comprehensive
and accurate system diagram detailing the Cisco ICM/IPCC production system’s private and
visible networks.

The private network is dedicated for Central Controller node communication and used to
establish, maintain, and restore synchronization between Central Controller nodes. The private
network must have sufficient bandwidth to simultaneously handle traffic associated with the
following:

• Synchronization of sides - side A and side B are synchronized in the event of the failure of
one side within a reasonable time

• State transfer - data transfer from active side CallRouter to the recovering side CallRouter

The visible network is a Cisco shared network for local node communication and remote node
communication with the Central Controller. The visible network must have sufficient bandwidth
to support traffic associated with the following:

• Active Directory synchronization

• Logger database recovery

• Heartbeats – messages sent every 100 milliseconds to the CallRouter and the PG to determine
if they are “alive” or functioning.

• Report inquiries

• Alternate path by fault tolerant software to distinguish between node failures and network
failures.

The ICM/IPCC system might also have a dedicated signaling access network. The signaling
access network is dedicated to the network interface controller (NIC) and to the ICM/IPCC
CallRouters.

Data Backup Plan

While you might perform normally scheduled backups of your data, you must define a plan for
backing up and restoring system critical data just prior to commencing an upgrade migration.
Refer to the following table to determine the system critical data you must back up and restore,
copy and paste, or export and import (based upon the upgrade migration method selected).
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Technology Refresh

Upgrade

Common Ground

Upgrade

System Critical Data

YesYesBackup the Logger SQL database(s).

YesYesBackup the Historical Data Server (HDS) SQL database(s).

YesYesBackup any custom databases.

YesYesBackup WVDB database on the Distributor AW.

YesYesExport the Cisco Systems, Inc. registry key on all production system
nodes.

YesYesCopy the icm directory on all production system nodes.

YesYesWebView users must backup custom templates and the WVDB on the
Distributor AW(s). The custom templates are in the
\ICM\<instance>\AW\custom directory.

Pre-upgrade Preparation for All ICM Servers

Pre-upgrade preparation is an integral part of the upgrade process. Perform the following on all
ICM servers to assist in recovery in the event of a catastrophic upgrade failure:

Step 1 Run the following commands and record output in the indicated files:

• Run: ipconfig –all Save results in ipconfig.txt.

• Command: route print –p Save results in route.txt.

• Command: netstat –a –n Save results in netstat.txt.

Step 2 Save the hosts file.

Step 3 Save the LMhosts file if applicable.

Network Configuration Backup

You must create a bootable image of the systems that includes the operating system and the
network configuration. This backup is a good business practice to assure system recovery in
case catastrophic conditions occur during the upgrade process.

Default Routing Plan

Document and validate your default network routing plan prior to the upgrade. When you cross
over from your old ICM/IPCC production system to your new ICM/IPCC system, the production
system is going to be down for a short period of time until the cross over is complete.
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Test Plan

Execute test cases at various stages of the upgrade based on your expectations. You must, at a
minimum, test the following areas:

• Pre-upgrade Application test

• Pre-upgrade System Integrity tests

• CTI functionality (as applicable)

• Configuration tools

• Reporting functionality

• Post-upgrade Application test

• Post-upgrade System Integrity tests

Perform test cases when side A is upgraded and running in non-fault tolerant mode, prior to the
upgrade of side B. Perform the test cases again when the ICM system is fully upgraded and
running in duplex mode.

In addition, schedule appropriate resources to ensure custom CTI functionality after an upgrade.

See Also

Upgrade Planning on page 7

Schedule of Activities

Due to the complexity of an ICM/IPCC production system, you must create a detailed schedule
of upgrade activities. This allows your Project Manager to maintain the status of each machine
upgrade. It also helps to use a chart indicating all of the ICM/IPCC nodes to be upgraded and
their upgrade status.

Upgrades are usually performed during off-peak hours. Keep in mind that you might require
more than one upgrade window. Normally, an initial maintenance window is established to get
the ICM/IPCC Central Controller and critical (key) AWs upgraded first. The remaining AWs
and PGs are then scheduled as early as maintenance windows allow.

Note: Ensure your AWs have been upgraded to ICM/IPCC Release 7.0(0) before bringing them
online.
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Definition of Upgrade Steps

The upgrade migration of an ICM/IPCC system involves numerous steps. From your initial
software load, you must install/upgrade the operating system, the ICM software (and options),
the database software, and any required third party software.

Be aware that, for a period of time during the upgrade migration, the ICM/IPCC system runs
in a non-fault tolerant mode. In addition, network default routing takes place when both sides
of the Central Controller are “stopped” during the cross over (see the Test Plan section).

Testing must take place when the side A Central Controller is upgraded and running. The upgrade
team must then come to consensus on the success of the testing and make a “go” or “no go”
decision to proceed with upgrading the side B Central Controller.

If critical problems are encountered after upgrading side A, the upgrade team could decide to
restore the side A Central Controller to the old/prior release.

Post-upgrade Test Definition

You must create a test plan for the various stages of the upgrade process to test your ICM system.
The following are examples of typical ICM system post-upgrade tests:

• Application test

• System Integrity tests:

– Process testing

– Redundancy testing

– Alarm testing

– Historical reporting testing

– WebView reporting testing (option)

– Internet Script Editor testing (option)

See the Run Post-Upgrade tests section for additional details.

Stakeholder Notification

The following ICM/IPCC associated personnel from the following organizations must be notified
of all upgrade activities and schedules.

• Cisco Technical Assistance Center (TAC)

• Local Cisco representative:
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– Account Manager

– Partner

– Support Engineer

• ACD and VRU Vendors

• Customer Operations and Emergency Management Center

Related Documents

When planning ICM system upgrades, familiarize yourself with Cisco Intelligent Contact
Management (ICM) documentation relative to ICM, IPCC, and Remote Monitoring Suite.

Review and have available the following documents when performing an ICM/IPCC 5.0(0) or
6.0(0) to ICM/IPCC 7.0(0) system upgrade:

• Cisco ICM/IPCC Software Documentation Set  (http://www.cisco.com/en/US/products/
sw/custcosw/ps1001/tsd_products_support_series_home.html)

Note: Carefully scrutinize the documentation set to ensure you understand the impact of the
upgrade process on any key functionality.

• Release Notes for Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)
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Part 2: ICM/IPCC Software Upgrade
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Getting to the Baseline
Prior to commencing an upgrade to ICM/IPCC 7.0, ensure your system meets all of the applicable
baseline requirements.

Baseline Requirements

The baseline requirements are as follows:

• All ICM nodes (CallRouter, Logger, NICs, AWs, PGs, CTI Server) at ICM/IPCC Release
5.0(0) or ICM/IPCC Release 6.0(0).

Note: The 5.0/6.0 systems must be functioning prior to upgrade. Minimal functional
requirements are: version and most recent service release are installed on all components,
the Logger data has completed entire migration process as stated in the 4.6.2 to 5.0/6.0 guide
(which includes completion of data migration), Historical Data Server has completed
replication (post upgrade), all components and features are functioning properly.

• All ICM/IPCC nodes running Windows 2000 SP4.
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Note: Prior to executing a Common Ground upgrade, the Active Directory Domain Controller
and DNS functionality must be moved off of any ICM components. Refer to "Migrating
Active Directory and DNS to a Non-ICM Server" for additional information.

• Logger, AWs, and HDS running SQL Server 2000 SP4.

• CAD at Release 4.6 or 6.0 on Windows 2000 Server SP4 and MSDE 2000 SP3a.

• CTI OS desktops at Version 4.7, 5.0, 5.1, or 6.0.

• CEM, CCS, CMB at Version 5.0.

• DCA at Version 2.1.

• CCM at Version 3.3, 4.0, or 4. 1, with the compatible IP IVR or CVP (ISN) version as per
the Cisco IP Contact Center Enterprise Edition Software Compatibility Guide.

Note:

• CCM 3.3 is supported only during the upgrade period.

• Refer to the Cisco IP Contact Center Enterprise Edition Software Compatibility Guide
for the compatibility between the Cisco CallManager version and the IP IVR and/or
CVP version.

• ACDs at a version compatible with ICM/IPCC 7.0(0).

Note: Refer to the Cisco ICM Software Supported Switches (ACDs) document for ACD
compatibility information.

• Hardware meets specifications in the Cisco ICM/IPCC Enterprise and Hosted Edition
Hardware and System Software Specification (Bill of Materials)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/products_user_guide_list.html). The hardware required
for both Technology Refresh and Common Ground upgrades is specified.

Note: If existing hardware is to be reused, verify that CPU and memory usage is below 50%
utilization prior to the upgrade. If CPU or memory usage is above 50%, or if new feature
usage or capacity increases (higher agent count, increased call rate, ECC increases) are
planned, then new hardware should be deployed.

• Active Directory Environment must be created and configured for ICM/IPCC.

Note: Refer to the Active Directory Considerations for Upgrades (page 45) for detailed
upgrade information.

• Windows firewall configuration scripts must be run to enable network connectivity.

• ICM/IPCC Support Tools Server upgraded to Version 2.0.

Note: Refer to the Support Tools Considerations for Upgrades (page 45) for detailed upgrade
information.

• Perform backup of existing servers and verify backups
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For additional information, refer to the Cisco ICM Software Upgrade Migration Guide ICM
4.6.2 to ICM/IPCC 5.0(0) and ICM 4.6.2 or ICM/IPCC 5.0(0) to ICM/IPCC Enterprise
Release 6.0(0), Chapter 3  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
prod_installation_guides_list.html)
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Common Ground Upgrades vs. Technology Refresh
Upgrades

ICM/IPCC Upgrade Methods

There are two supported ICM/IPCC upgrade methods:

• Common Ground (CG)

The Common Ground upgrade method is performed in place on the existing hardware if the
hardware has been evaluated and determined to meet the minimum requirements for Cisco
ICM/IP Contact Center, Release 7.0(0).

• Technology Refresh (TR)

The technology Refresh upgrade method is performed when you decide to (or it is required
that) upgrade your hardware as well as your Cisco ICM/IPCC software and supporting third
party software. The upgrade method consists of transporting all data, customized
files/information, and related registry keys to the new hardware previously configured with
a compatible operating system and database server (where required); then upgrading the
transported data to a new release of Cisco software. If the new hardware has been configured
within a new domain using the Domain Conversion Tool, it additionally entails moving users
from the old domain to the new domain.

Note: Upgrades involving Common Ground Upgrades on some ICM/IPCC nodes and
Technology Refresh on others are supported, however, the A and B side of any given
component must be running on identical hardware.
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Introduction to ICM/IPCC Upgrade
Upgrading a Cisco ICM/IPCC system involves numerous steps and the upgrade order of operation
is distinct. From your initial software load, you may need to upgrade the operating system, the
ICM/IPCC software (and options), the database software, and any required third party software.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

ICM/IPCC Upgrade Overview

A full ICM/IPCC system is made up of several individual components or nodes which can be
geographically dispersed. In moderate to large systems, it is not possible to upgrade all ICM/IPCC
components in the same maintenance window. The ICM/IPCC upgrade process allows the full
system to be upgraded over multiple maintenance windows.

This upgrade process applies to both Cisco ICM/IP Contact Center Enterprise and Hosted
editions.

Note: Prior to upgrading a production system, you are encouraged to perform the upgrade on
a lab system which mirrors your production system.

Refer to Upgrade Procedures (page 53). Select the example that is most applicable to your
ICM/IPCC system. Refer to the Upgrade Checklists (page 151) section for the checklist associated
with the previously chosen example procedure. Modify the checklist to suit your specific
situation, then use the modified checklist as a guide and record of progress throughout the
upgrade process.
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High Level ICM/IPCC 7.0 Upgrade Overview

Before you upgrade to ICM/IPCC 7.0(0), make sure your systems are in compliance with the
upgrade baseline requirements (page 17). If not, use the upgrade process as documented for
previous releases to get the system to the required baseline.

The following upgrade process overview outlines the high level steps to upgrade a complex,
multi-media, ICM/IPCC system.

Figure 1: Upgrading a Complex, Multi-media, ICM/IPCC System

High Level Upgrade Overview

1. Bring the system to the pre-upgrade baseline (page 17).

2. Perform a system backup.

3. Setup the new hardware and the Active Directory environment.

4. Upgrade the Side A Central Controller .

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

5. Verify Side A operation, then bring Side A into service.

6. Upgrade the Side B Central Controller(CallRouter (page 91), Logger (page 85), Distributor
AW and HDS (page 67), WebView Server (page 84), NICs).

The following steps can be performed in any order.

7. Upgrade the Client Administrator Workstations.

8. Upgrade the Peripheral Gateways and associated Outbound Option dialers (must be
upgraded at the same time as the Campaign Manager), and the CTI OS Servers.

9. No upgrade is required for the CIS components (CEM, CCS, CMB, DCA).

10. Upgrade the CTI OS desktops.

11. Upgrade the CAD Server and Desktops (must be done together).

12. Install Infomaker (for custom reports) on a dedicated server.

13. For Common Ground upgrades, upgrade the Windows operating system to Windows 2003.
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Note:

• ICM/IPCC 7.0(0) supports Windows 2000 for Common Ground upgrades only.

• In Hosted ICM/IPCC environments, the NAMs and CICMs can be upgraded separately and
in any order, provided that NAM/CICM compatibility is adhered to. ICM/IPCC 7.0(0) NAM
works with 5.0(0) and 7.0(0) CICMs. ICM/IPCC 5.0(0) NAM works with 4.6.2, 5.0(0), and
7.0(0) CICMs. ICM/IPCC 6.0(0) is not supported in a Hosted environment.
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ICM/IPCC 7.0(0) Upgrade Time and Space
Requirements

Introduction

Successful upgrade planning requires an understanding of the time and space requirements
necessary to upgrade the various ICM/IPCC components. The logger and HDS upgrades take
longer to upgrade than other ICM/IPCC nodes due to the time it takes to upgrade the HDS and
Logger databases.

For technology refresh upgrades, the network configuration between the source and target
hardware also effects the overall upgrade times.

A number of factors affect the database migration times:

The most critical parameters are:

• the overall database size

• the database profile

• the type of upgrade (Common Ground vs. Technology Refresh)

• ICM/IPCC 5.0 to ICM/IPCC 7.0 upgrade vs. ICM/IPCC 6.0 to ICM/IPCC 7.0 upgrade

• the hardware involved, especially the efficiency of the disk subsystem (see Appendix D)

Specific database tables can consume the majority of the overall data migration times due to
their typical size relative to the other database tables, and the operations which must be performed
on the tables during the upgrade.
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These tables are referred to in the document as the copy/drop tables. The following lists show
the copy/drop tables for each migration path.

Copy/Drop Tables for the Migration from ICM/IPCC 5.0

• Application_Event

• Call_Type_Half_Hour

• Event

• Network_Event_Detail

• Termination_Call_Detail

• Route_Call_Detail

Copy/Drop Tables for the Migration from ICM/IPCC 6.0

• Agent_Half_Hour

• Agent_Skill_Group_Half_Hour

• Application_Event

• Call_Type_Half_Hour

• Event

• Network_Event_Detail

• Skill_Group_Half_Hour

• Termination_Call_Detail

• Route_Call_Detail

Database Migration Performance

Prerequisites

EDMT requires additional disk space in which to copy and modify data and data structures
during the migration process. This requires that additional disk space is available to the database
to allow the database, database log file, temp db, and temp db log file to be able to grow.
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Calculate Necessary File Size

The following sections provide instructions on determining the requirements for your migration.

How to calculate the required disk space for the migration

Step 1 Use the ICMDBA tool to gather database information.

Step 2 Right-click on the database and select Properties.

Note: The Database Used Size = Percent Used of the Data Size Value.

Step 3 Determine and document the amount of rows and the size of the copy/drop tables.

To accomplish this:

• Select the database.

• Select Data > Space Used Summary.

Note: The default setting lists the largest tables.

Step 4 Calculate the required disk space for the migration.

If none of the copy/drop tables have more than 7,000,000 rows:

• Determine the DUS (Database Used Size).

• Determine the required disk space for the database migration where:

Required Disk Space = 2*DUS

If at least one of the tables listed above has more than 7,000,000 rows, and you are not able to
reduce the row count(s) to less than 7,000,000 then:

• Determine the following values:

TTSA (Total Table Size from all copy/drop tables

DUS (Database Used Size)

maxTSL (Table Size of the largest copy/drop table)

• Determine the database file size where:

Required Disk Space = [(2*DUS) - TTSA] + (2*maxTSL)
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Example for determining the disk space needed to complete the migration:

• Database Used Space (DUS) = 71,680 MB

• Copy/drop table size (TTSA) = 56,128 MB

• Largest Copy/drop table size (maxTSL) = 36,496 MB

• Required Disk Space = ((2 * 71,680) – 56,128) + 2(36,496) = 160,224 MB

Temp DB Size

Step 1 Ensure the Temp DB Log is able to expand to 3 GB.

Step 2 Ensure the Temp DB is able to expand to 50% of the DUS.

Upgrade Paths

There are two Logger and HDS migration paths:

• Technology Refresh

The Technology Refresh path is followed by customers replacing their existing Logger and/or
HDS servers with new hardware.

• Common Ground

The Common Ground path supports customers using the same Logger and/or HDS hardware
to run ICM/IPCC 7.0.

The data migration set is identical regardless of the migration path one chooses to follow.

Technology Refresh involves:

• Backup/Copy/Restore

• Data Migration

Common Ground only involves:

• Data Migration
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Time Guidelines and Migration Performance Values

Your best estimate of time and space requirements are generated by running EDMT against a
copy of your production database, on hardware (see Appendix D) similar to your production
environment, in a lab environment. For customers that do not have that ability the following
subsections provide information gathered while performance testing in the labs (see Appendix
E) at Cisco Systems, Inc.

Typical Database Migration Performance Values

The following table provides high level guidelines for the upgrade times for Loggers and HDSs
based on the hardware (as defined in the Cisco ICM/IPCC Enterprise and Hosted Edition
Hardware and System Software Specification (Bill of Materials)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/products_user_guide_list.html) and the results observed
during internal upgrade testing (see Appendix E). Actual times vary based on the parameters
previously discussed.

Backup, Network Copy, and Restore – Technology Refresh Only

Copy speed is dependent upon the speed of the network and the speed of the disk sub-system.
The faster the network the faster the copy completes.

Backup/Copy/Restore Time (Hours)Database Used Size (GB)

.5 – 110

1.5 – 2.520

2 - 440

3.5 – 570

Note:

• The values in the Database Used Size in the table above are based on the amount of disk
space used by the Source database, not the size of the disk it resides on.

• The Backup/Copy/Restore Times in the table above assume the network meets the minimum
requirements of the Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and
System Software Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/
sw/custcosw/ps1001/products_user_guide_list.html).

• For Technology Refresh upgrades, have the fastest network possible (gigabit through one
network switch) between the source and the destination machines. Use of a crossover cable
is not recommended because it lacks buffer memory and can cause data loss.
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Run Timings, Technology Refresh and Common Ground

The tables below provide high level guidelines for the upgrade times for Loggers and HDSs
based on the hardware as defined in the Cisco ICM/IPCC Enterprise and Hosted Edition
Hardware and System Software Specification (Bill of Materials)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/products_user_guide_list.html), and results observed
during internal upgrade testing. Actual times will vary based on the parameters discussed in the
Introduction to ICM/IPCC Upgrade (page 23).

Table 1: ICM/IPCC 5.0(0) to ICM/IPCC 7.0(0) Logger/HDS Upgrade Time Guidelines

Migration Time in HoursDatabase SizeLogger or HDSHardware

1 – 210 GBLoggerGEN-30-001-Class

0.5 – 1.510 GBLoggerMCS-30-001-Class

2 – 420 GBHDSMCS-30-001-Class

1 – 2.520 GBHDSMCS-40-003-Class

3 – 640 GBHDSMCS-40-003-Class

1 – 340 GBHDSGEN-50-004-Class

4 – 1170 GBHDSGEN-50-004-Class

Note: The actual data migration time is
effected by the distribution of data within the
database. For example, a database with only a
few records over the 7,000,000 copy/drop
migrates much faster than a database with
many large copy/drop tables.

Table 2: ICM/IPCC 6.0(0) to ICM/IPCC 7.0(0) Logger/HDS Upgrade Time Guidelines

Migration Time in HoursDatabase SizeLogger or HDSHardware

1 – 210 GBLoggerGEN-30-001-Class

0.5 – 1.510 GBLoggerMCS-30-001-Class

2.5 – 4.520 GBHDSMCS-30-001-Class

2 – 420 GBHDSMCS-40-003-Class

3 – 640 GBHDSMCS-40-003-Class

2 – 540 GBHDSGEN-50-004-Class

10 – 1570 GBHDSGEN-50-004-Class

Note: The actual data migration time is
effected by the distribution of data within the
database. For example, a database with only a
few records over the 7,000,000 copy/drop
migrates much faster than a database with
many large copy/drop tables.
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Performance Considerations

During internal testing, hyper-threading has consistently doubled the time it took the database
migration to complete; therefore, to minimize migration time one should disable hyper-threading.

Ways to Reduce Data Migration Time

How to reduce data migration time:

• Reduce database size.

– Purge the Logger DB of all data already replicated to the HDS (25 GB or less)

– Remove any unneeded records, especially RCD, RCV, TCD, and TCV tables via ICM
Purge Utility and/or SQL Query Analyzer.

Note: Removing records impacts the availability of historical reports. Knowledge of the
HDS schema is required.

• Use better hardware, especially on I/O subsystems.

– RAID 1 + 0

– I/O Cache – more is better

• For Technology Refresh upgrades, have the fastest network possible (gigabit through one
network switch) between the source and the destination machines. Use of a crossover cable
is not recommended because it lacks buffer memory and can cause data loss.
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Setting Up the Hardware

Technology Refresh Hardware Upgrade Prerequisites

Before undertaking a Technology Refresh upgrade, it's important that the newly deployed servers
be installed.

The Active Directory environment (whether corporate or dedicated to the ICM/IPCC applications)
must be configured/staged. The Windows Firewall configuration scripts must be deployed before
ICM/IPCC servers can accept network connections.

Note: Refer to the guidelines outlined in the Staging Guide, ICM/IPCC Enterprise/Hosted,
ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1001/prod_installation_guides_list.html).

Prior to performing a Technology Refresh upgrade on an ICM/IPCC node, new ICM/IPCC
7.0(0) Bill of Materials (BOM) compliant hardware must have the following software installed:

• Windows 2003 including latest supported service pack

• SQL Server 2000 including latest supported service release and required patches for the
ICM/IPCC nodes which require SQL (Logger, HDS, Distributor AW)

• Version 2.0 Support Tools agent

• VNC, PC Anywhere, Virus scanning, and any other required/desired third party software

Note:

• For additional information concerning the hardware and software requirements, refer to the
Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System Software
Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1001/products_user_guide_list.html)
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• Cisco Security Agent must not be installed on the new servers until the appropriate step in
the upgrade process. ICM setup checks for older versions of Cisco Security Agent and provides
warnings or prevents continuation if an older version of CSA is installed or running.

Common Ground Hardware Upgrade Prerequisites

Before beginning a Common Ground upgrade, be sure that the existing hardware meets the
requirements for ICM/IPCC 7.0(0) as specified in the Cisco ICM/IPCC Enterprise and Hosted
Edition Hardware and System Software Specification (Bill of Materials)  (http://
www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html).

Monitor CPU and memory usage to verify that there is sufficient “head room” to support the
new release. If CPU or memory usage on the existing system is greater than 50%, it is necessary
to upgrade the hardware.

How to set up the hardware

To accomplish this upgrade you must first:

• Stage all ICM/IPCC 7.0 machines in racks, or on a work surface, with the following:

– RAM installed

– Hard Drives installed

– RAID arrays configured

– Video and Ethernet Cards installed

– All multiple rack mount systems occupying the same rack are attached to keyboard, mouse
and monitor sharing unit

– All machines are labeled with a hostname as per Network Design diagram.

– All Ethernet connections are labeled “visible” or “private”.

– There are sufficient power outlets for all machines to be simultaneously connected and
turned on.

• Ensure there are at least 2 phone lines for testing of dial-up modem access

• Ensure all CDs (software), driver software on diskette or CD and Vendor documentation for
all platforms are in the work area

• Ensure all Software License Numbers are available

• Ensure the simulated ICM Network is in place and successfully tested:

– All LAN Switches are configured for required subnets per ICM System Diagram.
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– All IP CallRouters are configured as required

– IP connectivity between all subnets has been successfully tested

– Required Ethernet connections are in place between ICM platforms and LAN switches.

– Required Packet prioritization has been configured on IP CallRouters

For addition Windows and SQL Server staging information, refer to the Staging Guide,
ICM/IPCC Enterprise/Hosted, ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/prod_installation_guides_list.html)

Installing Microsoft Windows 2003

Note:

• For additional information on installing Microsoft Windows Server 2003, refer to the Windows
Server 2003 homepage  (http://www.microsoft.com/windowsserver2003/default.mspx)

• For additional information on the applicable Microsoft Windows Service Pack, refer to the
Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System Software
Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1001/products_user_guide_list.html)

Upgrading from Windows 2000 to Windows Server 2003 - Common Ground Upgrades Only

Upgrading from Windows 2000 to Windows Server 2003 requires a considerable amount of
planning and preparation. One of the first areas to consider is the source operating system
revision and most importantly edition. It is important to determine the nearest equivalent target
edition before engaging in the upgrade.

Note: It is only possible to upgrade to an equivalent or higher operating system. It is not possible
to “downgrade” to a less powerful operating system, as some functionality might be lost in the
process.

For example, it is not possible to upgrade a server OS from Windows 2000 Server (or other
server products in the Windows 2000 family) to the Windows Server 2003, Web Edition without
removing the earlier operating system and performing a new installation.

The following table outlines the relationships between the Windows Server 2000 and Windows
Server 2003 editions.

Note: The Windows 2003 Web Edition is not supported for any ICM 7.0(0) node.

Table 3: Windows 2000 and Windows 2003 Relationships

Windows 2003 FamilyWindows 2000 Server Family

Standard EditionWindows 2000 Server
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Windows 2003 FamilyWindows 2000 Server Family

Enterprise EditionWindows 2000 Advanced Server

Web EditionNo Equivalent

Before upgrading to Windows Server 2003, the computer being upgraded must meet the system
requirements, and all hardware components and Third Party Software are compatible with the
operating system. The hardware requirements for the Windows 2003 operating system are
exceeded by the ICM hardware requirements specified in the Cisco ICM/IPCC Enterprise
and Hosted Edition Hardware and System Software Specification (Bill of Materials)  (http:/
/www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html).

Windows 2003 Hardware Compatibility

One of the most important steps to take before running Setup on a server is to confirm that the
hardware is compatible with products in the Windows Server 2003 family. This is accomplished
by running a pre-installation compatibility check from the OS Setup CD or by checking the
hardware compatibility information available on the Microsoft Windows Server 2003 Web site.
Also, as part of confirming hardware compatibility, check to see that you have obtained updated
hardware device drivers and an updated system BIOS.

If a mass storage controller (such as a SCSI, RAID, or Fibre Channel adapter) is used for the
server hard disk(s), confirm that it is compatible with products in the Windows Server 2003
family. If the controller is compatible with products in the Windows Server 2003 family, but
the manufacturer has supplied a separate driver file for use with your operating system, obtain
the file (on a floppy disk) before running the Windows 2003 setup. During the early part of
Setup, a line at the bottom of the screen prompts you to press F6. Further prompts guides you
in supplying the driver file to Setup so that it can gain access to the mass storage controller.

If you are not sure whether you must obtain a separate driver file from the manufacturer of your
mass storage controller, you can try running Setup. If the controller is not supported by the
driver files on the Setup CD, and therefore requires a driver file supplied by the hardware
manufacturer, Setup stops and displays a message saying that no disk devices can be found, or
displays an incomplete list of controllers. After you obtain the necessary driver file, restart
Setup, and press F6 when prompted.

Regardless of whether you run a pre-installation compatibility check, Setup checks hardware
and software compatibility at the beginning of an upgrade or new installation and displays a
report if there are incompatibilities.

For a comprehensive list of hardware and software supported by the Windows Server 2003
operating system, see the Windows Server Catalog  (http://www.microsoft.com/windows/
catalog/server/).

For more information, see Windows Server 2003 Support  (http://www.microsoft.com/
windowsserver2003/support/ ) or the online Product Documentation for Windows Server
2003  (http://www.microsoft.com/windowsserver2003/proddoc/).
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Active Directory Considerations for Common Ground Upgrades

In Windows Server 2003, Active Director domains can operate at three functional levels:

• Windows 2000 mixed (includes domain controllers running Windows 2000, Windows NT
4.0, and Windows Server 2003). This is the default setting.

• Windows 2000 native (includes domain controllers running Windows 2000 and Windows
Server 2003)

• Windows Server 2003 (only includes domain controllers running Windows Server 2003)

Once all domain controllers are running on Windows Server 2003, you can raise the Domain
and Forest Functionality to Windows Server 2003 by opening Active Directory Domains and
Trusts, right-clicking the domain for which you want to raise functionality, and then clicking
Raise Domain Functional Level.

Note: Once you raise the domain functional level, domain controllers running earlier operating
systems cannot be introduced into the domain. For example, if you raise the domain functional
level to Windows Server 2003, domain controllers running Windows 2000 Server cannot be
added to that domain.

It’s important to ensure that prior to the upgrade of ICM to release 7.0(0), the Active Directory
mode in Windows 2000 be set to native mode. This is required by the ICM application, which
fails to create the necessary user accounts and groups in the domain if it isn’t at least in this
mode. ICM Setup, through the Domain Manager tool, has the ability to detect the domain mode
and prevents users from installing the application if it finds that the Active Directory functional
level (Windows Server 2003) or mode (Windows 2000) is running mixed.

References: How to upgrade Windows 2000 domain controllers to Windows Server 2003
(http://support.microsoft.com/default.aspx?scid=kb;en-us;325379)

This article discusses how to upgrade Microsoft Windows 2000 domain controllers to Microsoft
Windows Server 2003 and how to add new Windows Server 2003 domain controllers to Windows
2000 domains.

Internet Information Services (IIS) 6.0 Considerations for Common Ground Upgrades

When upgrading from Windows 2000 Server with IIS 5.0 to one of the following operating
systems:

• Windows Server 2003 operating system, Standard Edition

• Windows Server 2003 operating system, Enterprise Edition
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The World Wide Web Publishing Service (WWW service) is not enabled by default due to
increased security measures. If you have already upgraded, you can start the WWW service by
using the Services snap-in.

If you have not yet upgraded and you want the WWW service to be enabled by default after
you upgrade, you must perform one of the following steps before you start the upgrade:

• If you have not already done so, run the IIS Lockdown Tool on the computer that you want
to upgrade. The IIS Lockdown Tool reduces the web server's exposure to attack by disabling
unnecessary features and giving you the choice to enable and customize features for your
site. This tool is available from the Microsoft Web site. A description of how to run this tool
is detailed in the Security Best Practices Guides for Cisco ICM 5.0 and 6.0.

• Create the registry key RetainW3SVCStatus under the node: yahoo

\SYSTEM\CurrentControlSet\Services\W3SVC, and then add a DWORD value of any name
equal to 1.

For example, create the key:
KEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W3SVC
\RetainW3SVCStatus\do_not_disable with the DWORD value of 1.

• Add the entry "DisableWebServiceOnUpgrade = false" to the script that you use to perform
an unattended installation. After the upgrade is complete, ensure that all unnecessary IIS
features have been removed or disabled and that the enabled features are configured with the
highest security settings that your organization can support.

Operating System Upgrade Considerations for WebView

When upgrading the Operating System on a server with WebView Server installed, the following
steps must be performed:

Step 1 Upgrade the operating system to Windows 2003 with the latest supported service pack.

Note: For additional information on the applicable Microsoft Windows Service Pack, refer to
the Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System Software
Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
products_user_guide_list.html).

Step 2 Run the ICM Third-Party Installer and re-install the New Atlanta ServletExec ISAPI component.

Note: The JDK or EA Server must not be re-installed.

Step 3 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the WebView server. Edit the WebView
component and continue all the way through setup for the component to re-install and re-configure
the WebView files.
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Installing Microsoft SQL Server 2000

SQL Server 2000 is only installed on Loggers, HDS, or AWs. ICM/IPCC 7.0(0) supports MS
SQL Server 2000 Standard and Enterprise Editions.

The following is an overview of the SQL Server 2000 installation:

1. Copy all of the files on the SQL Server 2000 CD to a directory on your drive.

2. Install SQL Server 2000.

3. Install the SQL Server service pack(s).

How to Install Microsoft SQL Server 2000

SQL Server 2000 is only installed on Loggers, HDS, or AWs.

For addition Windows and SQL Server staging information, refer to the Staging Guide,
ICM/IPCC Enterprise/Hosted, ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/
univercd/cc/td/doc/product/icm/icmentpr/icm70doc/microsf7/index.htm)

Step 1 Run autorun.exe.

Step 2 Select SQL Server 2000 Standard Edition to start SQL Server setup.

Step 3 On the first screen:

a. Select Install SQL 2000 Server Components.

b. Select Install Database Server.

c. Read the Welcome screen.

d. Click Next.

Step 4 On the Computer Name screen:

a. Choose the default, Local Computer.

b. Click Next.

Step 5 On the Installation Selection screen:

a. Choose the default, Create a new instance of SQL Server.

b. Click Next.

Step 6 On the User Information screen:
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a. Enter the user name and company name.

b. Click Next.

Step 7 On the Software License Agreement screen:

a. Read the terms of the license agreement, then click Yes.

Step 8 On the Installation Definition screen:

a. Choose the default Server and Client Tools.

b. Click Next.

Step 9 On the next screen:

a. For Instance Name, check Default.

b. Click Next.

Step 10 On the Setup Type screen:

a. Select Custom for the setup type.

b. Install the program files to any disk with space available (default is C:).

Note: MS SQL disk space requirements: 270 MB (full installation), 250 MB (typical), 95 MB
(minimum), 44 MB (Desktop Engine) plus Analysis Services: 50 MB minimum and 130 MB
typical and 80 MB for the English Query. Check your MS SQL documentation for additional
information.

Step 11 On the Select Components screen:

a. Uncheck Install Books Online.

b. Leave all other fields set to their default values.

c. Click Next.

Step 12 Under Services Accounts select items in exactly this order:

a. Select SQL Server.

b. Select Customize settings for each service.

c. Select Use domain account (refer to the Staging Guide, ICM/IPCC Enterprise/Hosted,
ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/univercd/cc/td/doc/product/
icm/icmentpr/icm70doc/microsf7/index.htm)).

d. Check Auto-start service.

e. Select SQL Server Agent.
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f. Select Customize settings for each service.

g. Check Auto-start service.

h. Click Next.

i. A pop-up dialog explaining a dependency appears, click OK.

Step 13 Under Authentication Mode:

a. Select the Windows Authentication or the SQL Authentication mode.

If you select the Windows Authentication mode enter the:

1. ICM instance name

2. Login ID

3. User password

Note: User must be able to log into the ICM Logger with read privileges.

If you select the SQL Authentication mode enter the:

1. ICM instance name

2. Login ID

3. User password

Note: User must have read access to the ICM Logger database.

• Enter

b. Click Next.

Step 14 On the Collation Settings screen:

a. Click Collation Designer.

b. Be sure that Latin1_General is selected.

Note: See Using the EDMT to Verify System Conditions (page 77) for other acceptable collation
values.

c. Set the Sort Order to Binary.

d. Leave other files set to their default values.

e. Click Next.
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Step 15 Under Network Libraries:

a. Uncheck all choices except for Named Pipes and TCP/IP Sockets unless instructed
otherwise.

For Named Pipes, the pipe reads \\.\pipe\sql\query.

For TCP/IP Sockets, the Port number is 1433.

b. Click Next.

Step 16 On the Start Copying Files screen:

a. Read and click Next.

Note: Prior to completing the Licensing dialog box, refer to the Cisco ICM/IPCC Enterprise
and Hosted Edition Hardware and System Software Specification (Bill of Materials)  (http:/
/www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html) "SQL
Server 2000 Licensing" section. In addition, ensure you meet all the terms of the licensing
agreement between you and your software OEM.

Step 17 In the Licensing dialog box, select the Licensing method and the number of devices or
connections, as appropriate. Click Continue.

Note: If you choose Processor License, make sure there are sufficient concurrent connection
licenses so that the system does not run into licensing problems. A minimum of 40 concurrent
connections is required, though the precise number depends on the accessing need.

Step 18 A dialog box with the message "Setup is installing Microsoft Data Accessing Components
(MDAC) ..." appears.

Note:

• Occasionally, MDAC installation fails. The remedy is to download MDAC 2.7, or later, from
a Microsoft web site and install it. Once MDAC has been installed, run SQL Server setup
again.

• If a message box for Configure SQL Server Agent pops up, click OK.

The SQL 2000 installation is now complete.

Step 19 Install the appropriate SQL Server Service Pack.

Note: For additional information on the applicable Microsoft SQL Server Service Pack, refer
to the Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System Software
Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
products_user_guide_list.html).

a. Download the appropriate SQL Server service pack from the Microsoft web site.

b. Following the instructions provided with the service pack, install it.
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c. Verify the Network Library protocol order (Named Pipes first, then TCP/IP) using the
SQL Client Network Utility.

Support Tools Considerations for Upgrades

Before upgrading any of the ICM Core components (using either the Technology Refresh or
the Common Ground method), upgrade the existing ICM Support Tools server to version 2.0.
This is required for compatibility with the Version 2.0 Support Tools agents which is installed
on the ICM nodes during the upgrade process. The Version 2.0 Support Tools server is compatible
with older Support Tools agents.

Active Directory and DNS Considerations for Upgrades

Active Directory Considerations for Technology Refresh Upgrades

This upgrade method includes the process of migrating users from one domain to another using
the Domain Conversion Tool. The new servers must be in the Active Directory domain in the
appropriate ICM organization unit. IP connectivity and remote access must be validated.

For the ICM/IPCC 7.0(0) release, the Logger cannot be the AD domain controller. When setting
up the Active Directory environment, if the existing Loggers are also domain controllers, it may
be necessary to migrate the domain controller roles to new non-ICM servers prior to the upgrade.
Using the Active Directory tools provided with the Windows operating system, bring up the
new domain controllers on the domain in which the ICM operates, transfer any applicable
flexible single master operations (FSMO) roles, and then demote the domain controller on the
production Logger to a member server. Refer to "Migrating Active Directory and DNS to a
Non-ICM Server" for additional information.

Note: The Windows 2000 Operating System is not supported for ICM/IPCC release 7.0(0)
Technology Refresh upgrades.

Active Directory Considerations for Common Ground Upgrades

Before undertaking a Common Ground upgrade, the Active Directory environment (whether
corporate or dedicated to the ICM/IPCC applications) be configured or staged. The Windows
Firewall configuration scripts must be deployed before ICM/IPCC servers can accept network
connections.

For additional information, refer to the guidelines outlined in the Staging Guide, ICM/IPCC
Enterprise/Hosted, ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/en/US/
products/sw/custcosw/ps1001/prod_installation_guides_list.html)

The new Active Directory environment must be set up prior to beginning the upgrade process.
For the ICM/IPCC 7.0(0) release, the Loggers cannot host the AD domain controllers. If this
is the existing configuration, it is necessary to migrate the domain controllers to a non-ICM
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servers. Perform the AD and DNS migration well in advance of the actual upgrade to allow
time for implementation and stabilization. Repeat this for all Domain Controllers currently on
ICM servers. Use the Active Directory tools provided with the Windows operating system, and
bring up the new domain controllers on the domain in which the ICM operates. Transfer any
applicable flexible single master operations (FSMO) roles, and then demote the domain
controllers on the Logger to member servers. Refer to "Migrating Active Directory and DNS
to a Non-ICM Server" for additional information.

Note: This process may require the Logger to be down during demotion and transfer of the
domain controller.

The Windows 2000 Operating System is only supported for Common Ground upgrades, but
the operating system must be upgraded to Windows 2003 SP1 on all ICM core components or
Windows XP on client AWs before the upgrade is considered complete.

There are two methods by which you can ensure your systems are hardened:

1. Before engaging in the upgrade of the application, apply the security best practices outlined
in the Security Best Practices Guide for Release 5.0 and the Guide for 6.0 depending on
source release.

2. After upgrading the application on Windows 2000, upgrade the Operating System to
Windows Server 2003 and apply the automated hardening provided by the application at
this OS revision. This can be accomplished by re-running ICM setup and choosing to
apply the hardening when prompted, or by apply the security hardening from the command
line as outlined in the Release 7.0(0) Security Best Practices Guide for Windows Server
2003.

Domain Conversion Tool and Active Directory

The Technology Refresh upgrade method includes the process of migrating users from one
domain server to another using a tool called the Domain Conversion Tool. The new servers
must be in the Active Directory (AD) domain, the Active Directory environment must be set
up, and the instances added to the appropriate ICM organizational unit (OU). IP connectivity
and remote access must be validated.

When Instance Organizational Units are created by the ICM Domain Manager, user accounts
in the old ICM/IPCC security groups are automatically copied to new security groups in the
ICM/IPCC 7.0(0) Instance OU. The old groups are not modified.

Note: If you create new user accounts in the old ICM/IPCC 5.0 or ICM/IPCC 6.0 system after
the new ICM/IPCC 7.0 instance OUs were created, these accounts will not be valid in the new
ICM/IPCC 7.0 system.

ICM Setup verifies that AD configuration is complete and does not proceed until it is. All ICM
Instance information is required to allow you to configure the Active Directory Organizational
Units.
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Note: Prior to executing a Common Ground upgrade, the Active Directory Domain Controller
and DNS functionality must be moved off of any ICM components. Refer to "Migrating Active
Directory and DNS to a Non-ICM Server" for additional information.

For addition Windows and SQL Server staging information, refer to the Staging Guide,
ICM/IPCC Enterprise/Hosted, ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/prod_installation_guides_list.html)

Migrating Active Directory and DNS to Non-ICM Servers

Perform the AD and DNS migration well in advance of the actual upgrade to allow time for
implementation and stabilization. Repeat this for all Domain Controllers currently on ICM
servers.

Overview

• Using the Active Directory tools provided with the Windows operating system, bring up the
new domain controllers on the domain in which the ICM operates.

For additional information, refer to:

– How to install Active Directory on the new Domain Controller,

– How to install DNS,

– How to configure Active Directory sites on the new Domain Controller.

• Transfer any applicable flexible single master operations (FSMO) roles and redefine the time
source.

For additional information, refer to:

– your ICM System Diagram and the ICM/IPCC System Design Specification for your
implementation.

– How to redefine the time source.

• Set the new Domain Controller as the Global Catalog (if required).

For additional information, refer to:

– your ICM System Diagram and the ICM/IPCC System Design Specification for your
implementation.

• Point all member servers to the new DNS servers.

For additional information, refer to:

– How to configure member servers to point to the new DNS servers.

• Demote the domain controller on the production Loggers to member servers.
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For additional information, refer to:

– How to demote current Domain Controllers to member servers.

• Uninstall DNS from the 5.0 and 6.0 ICM servers.

For additional information, refer to:

– How to uninstall DNS from ICM 5.0(0) and 6.0(0) servers.

How to install Active Directory on the new Domain Controller

Step 1 Select Start > Run then enter dcpromo and click OK.

Step 2 When the Active Directory Wizard opens, click Next.

Step 3 Under Domain Controller Type select Additional Domain Controller for an Existing Domain.

Step 4 On the Network Credentials screen, enter the domain admin username and password.

Step 5 The Additional Domain Controller screen should already be filled in properly with the FQDN
(Fully Qualified Domain Name).

Step 6 Accept the database and log location defaults.

Step 7 Accept the shared System Volume defaults.

Step 8 Enter the same Restore Mode Admin password that was utilized on the Root Domain Controller.

Step 9 Check Summary Settings. Active Directory is not configured via NETLOGON.

Step 10 Reboot when the Active Directory installation is complete.

Step 11 Repeat theses steps for a new alternate Domain Controller if necessary.

How to install DNS

Step 1 Select Settings > Control Panel > Add/Remove Programs.

Step 2 Select Add\Remove Windows Components then check Networking Services > Details.

Step 3 Check DNS.

Step 4 Select OK then click Next.

Step 5 Browse to the Windows 2000 CD – DNS installs.

Step 6 Validate that all DNS Zones were replicated from the 1st DNS Server in the Active Directory
Domain, to this DNS Server.
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Step 7 Repeat this installation for the new Secondary DNS server (if required).

How to configure Active Directory sites on the new Domain Controller

Step 1 Move the new Domain Controller to correct site(s).

How to move FSMO roles as indicated in the ICM System Diagram and per settings in your ICM/IPCC System Design
Specification

Step 1 On the Active Directory Domain Controller hosting the role to be moved, open AD Users and
Computers, then connect to the Domain Controller to which the role needs to be moved.

Step 2 Right-click under the domain name and select Operations Masters.

Step 3 Under the required FSMO role tab, change the Operations Master to this designated DC.

How to redefine the time source

Since the PDC Emulator is moving to another Domain Controller, the time source must be
redefined as either that server or an external time source.

Step 1 On the server currently running the Primary Domain Controller Emulator, run the following
command: Net time /setnstp: <DNS name of time source>

Step 2 To synchronize a member server to the time source, run the following command: W32tm /s:
<DNS name of external time source>

How to assign Global Catalogs per the GC and FSMO plan in the ICM System Diagram and per settings in your
ICM/IPCC System Design Specification

Step 1 Open AD Sites and Services.

Step 2 Connect to the Domain Controller designated as the Global Catalog.

Step 3 Right-click NTDS Settings, click Properties, check Global Catalog, and click OK.

Step 4 Repeat this procedure on all ICM servers.

How to configure member servers to point to the new DNS servers

Step 1 In the Network Settings, open the Visible network connection
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Step 2 Open TCP/IP properties.

Step 3 Enter the new primary and alternate DNS servers.

Step 4 Run ipconfig /flushdns from a command prompt.

Step 5 Verify name resolution by pinging the ICM servers by name.

Step 6 Ping the ICM domain by name.

How to demote current Domain Controllers to member servers and uninstall DNS

Note: Important: Prior to demoting domain controllers make certain that the replication process
from the old domain controllers to the new domain controllers has completed. Check the directory
service with the event viewer to monitor the status. In a large domain it could be 30 minutes or
more for this process to complete.

Step 1 Select Start > Run, then enter dcpromo. When the Active Directory Wizard opens, click Next.

Step 2 A dialog box indicating that this server is already a Domain Controller appears. Click Next to
demote it to a member server.

Step 3 You are warned and prompted as to whether or not this is the last server in the domain. Leave
the box unchecked and click Next.

Dialogs then show the progress of the Domain Controller removal.

Step 4 Click Next to finish.

Step 5 Repeat this procedure for the alternate Domain Controller.

Step 6 Select Start > Settings > Control Panel > Add/Remove Programs.

Step 7 Select Add/Remove Windows Components > Networking Services.

Step 8 Click Details.

Step 9 Uncheck DNS, then click OK.

Step 10 Click Next.

Perform System Integrity Tests

The purpose of the sample test cases in this section is to validate basic ICM functionality and
fault tolerance prior to, during and after each step of the Migration Project. Refer to Appendix
B for additional System Integrity test information.
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Perform the following System Integrity Tests in the order listed:

• System Integrity Test 1 – Zero ICM Process Errors

• System Integrity Test 2 - RTTEST

• System Integrity Test 3 - OPCTEST

• System Integrity Test 4 - Call Router Fault Tolerance

• System Integrity Test 5 - PG Fault Tolerance

• System Integrity Test 6 - AW Configuration and Scripting Tools

• System Integrity Test 7 - Webview

• System Integrity Test 8 - Internet Script Editor

Verify System Conditions Using EDMT (Technology Refresh)

Run EDMT on the new hardware in advance of the actual upgrade to verify the following
conditions:

• Connections to the source and destination databases are available

Note: Unnecessary for a Common Ground upgrade.

• The collation value for the source and destination databases is:

– Latin1_General_BIN (for western/European languages -English, French, Spanish, German,
etc.)

– Japanese_BIN (for Japanese)

– Chinese_PRC_BIN (for Chinese)

– Korean_Wansung_BIN (for Korean)

– The source and destination databases are using the same collation value.

• The operating system is Windows 2003

• SQL Server 2000 is installed

• The ICM schema for the source is correct

– 77 for ICM/IPCC Release 5.0(0)

– 84 for ICM/IPCC Release 6.0(0)
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Once these checks are made, an "Are You Sure" dialog box is presented. When these checks
are complete, select Cancel.

Note: If adequate disk space is not available, a temporary server must be configured to store
the data moved from the non-upgraded system. The temporary server does not need to have
SQL Server installed. Using a temporary database server results in increased data migration
times because the data is moved across the network twice instead of once. The temporary
database server location is entered in the Backup Connection panel of the wizard. The upgrade
procedures and times indicated in the following sections assume that a temporary server is not
required.

When EDMT backs up the database from the production Logger or HDS, it stores the data in
one backup file, even if the data section of the database is broken up into separate data files
(data0, data1, data2, etc.), and/or the log section is broken up into separate files (log0, log1,
log2, etc.).

Each of the files could potentially be on separate logical or physical disk drives. EDMT only
allows one restore location. This is the desired ICM configuration since the disk configuration
of the new hardware would have to exactly match the configuration of the original system, and
that may not make sense with newer hardware.
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Upgrade Procedures
Determine which of the following upgrade examples is similar to your system. Follow the
procedures for each step indicated in the Reference column.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

This section contains the following topics:

• Technology Refresh Upgrade Examples, page 53
• Common Ground Upgrade Examples, page 59
• ICM/IPCC Component Upgrade Process, page 65

Technology Refresh Upgrade Examples

Before undertaking a TR upgrade, it's important that the newly deployed servers be installed.
The Active Directory environment (whether corporate or dedicated to the ICM/IPCC applications)
must be configured/staged. The Windows Firewall configuration scripts must be deployed before
ICM/IPCC servers can accept network connections.

Note: For addition Windows and SQL Server staging information, refer to the Staging Guide,
ICM/IPCC Enterprise/Hosted, ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/
en/US/products/sw/custcosw/ps1001/prod_installation_guides_list.html)

Two technology refresh examples are provided below. Both examples assume redundant
configurations with Side A and Side B Routers and Loggers, and that Side A and Side B
HDS/Distributor AWs are part of the system being upgraded and are required to support the
number of reporting users. The examples therefore include the deployment of a temporary
HDS/Distributor AW to maintain maximum system functionality and reporting capacity during
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the upgrade process. The deployment of a temporary HDS/Distributor AW may not be necessary
depending on the contact center hours of operation, the estimated upgrade time for each
ICM/IPCC node (for additional information refer to Chapter 5: ICM/IPCC 7.0(0) Upgrade Time
and Space Requirements (page 27)), whether one or two HDS/Distributor AWs are deployed,
the reporting user capacity required during upgrade, and other operational factors. The temporary
HDS/Distributor AW does not provide historical reporting, only real-time reporting is provided.
Both examples assume Side A is upgraded first, although the B side can be upgraded first.

Technology Refresh Example 1: Production HDS/Distributor AW Upgraded in Parallel with the Central Controller

In the first example, the production HDS/Distributor AW is upgraded in parallel with the central
controller. If necessary, an ICM/IPCC 7.0(0) temporary HDS/Distributor AW is configured
prior to central controller upgrade maintenance window to enable real-time reporting and
configuration during the time that the production HDS/Distributor AW is off-line being upgraded.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

Table 4: How to perform a TR upgrade where the production HDS/Distributor AW is upgraded in parallel with the Central

Controller Upgrade Maintenance Window

CommentsReferenceActionTime EstimateStep

None.Baseline Requirements
(page 17)

Upgrade the production
system to the required
baseline.

None.1

No impact on the production
system.

Domain Conversion
Tool and Active
Directory (page 45)

Create the Active Directory
environment.

None.2

No impact on the production
system.

Setting Up the
Hardware (page 35)

Set up the new hardware.None.3

Required to enable configuration
and real-time reporting while the

Set Up a Temporary
ICM/IPCC 7.0(0)
AW/HDS (page 80)

Set up a temporary 7.0
HDS/Distributor AW.

1 hour4

Side A HDS/Distributor AW is
being upgraded.

************************************************Start of
Central
Controller
Upgrade
Maintenance
Window

Step 6 can begin as soon as the
EDMT tool is configured and
running.

Distributor AW/HDS
Technology Refresh
Upgrade (page 70)

Upgrade the Side A
HDS/Distributor AW.

1 hour + data
migration time

5

Reporting capacity is diminished
until the completion of the Side B

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

54

Chapter 7: - Upgrade Procedures

Technology Refresh Upgrade Examples



CommentsReferenceActionTime EstimateStep

Logger, CallRouter and AW/HDS
upgrade and side B is brought back
into service.

Routing is done by the
non-upgraded system.

Logger Technology
Refresh Upgrade: Side
A/B (page 85)

Upgrade the Side A Logger.1 hour + data
migration time

6

Both existing CallRouters are
duplexed.

The Logger is simplex.

Configuration changes are
disabled.

The production system is running
simplex on Side B.

CallRouter Technology
Refresh Upgrade: Side
A/B (page 91)

Upgrade the Side A
CallRouter.

1 hour7

None.WebView Installation

Guide1
Install the WebView
server(s) if not collocated
on the AW/HDS.

1 hour per
server

8

Default routing occurs from the
shutdown of the existing system

None.Bring down the production
system (CallRouters,
Loggers, and AWs).

1+ hours
depending on
number of PGs

9

until the new Side A CallRouter
and CIS
components

and Logger are brought into
service.Bring up the new Side A

CallRouter and Logger.
Real-time reporting is provided via
the temporary HDS/Distributor
AW set up in step 4.

Point the temporary
HDS/Distributor AW, PGs,
and CIS components to the
new CallRouter & Logger
in the new domain.

Historical reporting is not available
until the Side A AW/HDS upgrade
is complete and brought back on
line. Reporting capacity remains
reduced until the completion of the
Side B Logger, CallRouter and
AW/HDS upgrade and side B is
brought back into service.

Routing is simplex until the Side
B CallRouter is upgraded and
brought into service.

CallRouter Technology
Refresh Upgrade: Side
A/B (page 91)

Upgrade the Side B
CallRouter.

1 hour10

Configuration is enabled once the
Side B Logger is upgraded and
brought into service.

Logger Technology
Refresh Upgrade: Side
A/B (page 85)

Upgrade the Side B Logger.1 hour + data
migration time

11

************************************************End of
Central
Controller

1) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsReferenceActionTime EstimateStep

Upgrade
Maintenance
Window

This can begin at any point after
Step 9.

Distributor AW/HDS
Technology Refresh
Upgrade (page 70)

Upgrade the Side B
HDS/Distributor AW.

1 hour + data
migration
time2-5 hours
(1-80 GB)

12

Historical reporting is available
once the HDS is brought into
service.

None.Bring up the Upgraded Side
A HDS/Distributor AW(s),
when available, at any point
after Step 8.

Included in
time estimate
for Step 5.

13

Real-time reporting is available via
the temporary HDS/Distributor
AW.

As soon as the upgraded
AW/HDS is brought on line
bring down the temporary

Overall reporting capacity is
restored via the combination of the

AW/HDS currently pointing
to the A side. If reporting

Side A and temporary
HDS/Distributor AWs.

capacity dictates, the
temporary AW/HDS could
be pointed to the B side
until the B side AW/HDS
upgrade is complete.

The temporary HDS/Distributor
AW can be decommissioned once

None.Bring up the Upgraded Side
B HDS/Distributor AW.

Included in
time estimate
for Step 12.

14

the Side B HDS/Distributor AW is
brought into service.

Full reporting functionality and
capacity is available at this point.

None.Administrative
Workstation (AW)

Upgrade the AWs, PGs,
RMS, and CIS components.

1 hour per node15

Upgrade Procedures
(page 67)

PG Technology Refresh
Upgrade (page 100)

Remote Monitoring
System (RMS) Upgrade
Procedures (page 123)

CIS Upgrade
Procedures (page 117)
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Technology Refresh Example 2: Production HDS/Distributor AW Upgraded Before the Central Controller Upgrade
Maintenance Window

In the second example, the production HDS/Distributor AW is upgraded before the central
controller upgrade maintenance window. If a secondary HDS/Distributor AW is not available,
a release 5.0 or release 6.0 temporary HDS/Distributor AW is set up to enable real-time reporting
and configuration between the time that the Side A HDS/Distributor AW is upgraded and the
time that the Upgraded HDS/Distributor AW is upgraded and the time the CallRouter, Logger,
and Distributor AW are brought into service.

For a technology refresh upgrade of an HDS/Distributor AW, it is only necessary to bring the
source HDS off-line during the backup/restore and registry export process.

Note: Instead of configuring and deploying a temporary release 5.0 or release 6.0
HDS/Distributor AW, you also have the option of bringing the source HDS back on line. This
option is not recommended if maximum reporting capacity and functionality is required during
upgrade, since the intent is to upgrade the Side A HDS/Distributor AW well in advance of the
Central Controller upgrade maintenance window. If you do choose this option, ensure the Logger
purge setting is long enough to prevent data loss.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

Table 5: How to perform a TR upgrade on a system where the production HDS/Distributor AW is upgraded before the Central

Controller upgrade maintenance window:

CommentsReferenceActionTime EstimateStep

None.Baseline Requirements
(page 17)

Upgrade the production
system to the required
baseline.

None.1

No impact on the production
system.

Domain Conversion Tool
and Active Directory
(page 45)

Create the Active
Directory environment.

None.2

No impact on the production
system.

Setting Up the Hardware
(page 35)

Set up the new hardware.None.3

Required to enable configuration
and real-time reporting until the

Setting Up a Temporary
ICM/IPCC AW/HDS
(page 80)

Set up a temporary
release 5.0(0) or release
6.0(0) HDS/Distributor
AW.

1 hour4

upgraded CallRouter, Logger, and
HDS/Distributor AW are brought
into service.

If a Side B HDS/Distributor AW is
available and the reporting capacity
of two HDSs is not required, it is
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CommentsReferenceActionTime EstimateStep

not necessary to set up the
temporary HDS/Distributor AW.

Complete this step before the start
of the Central Controller upgrade
maintenance window.

Distributor AW/HDS
Technology Refresh
Upgrade (page 70)

Upgrade the Side A
HDS/Distributor AW.

1 hour + data
migration time

5

Reporting is provided by the Side
B HDS/Distributor AW and/or the
temporary HDS/Distributor AW.

In place of the temporary
HDS/Distributor AW, it is also
possible to bring the un-upgraded
HDS/Distributor AW back into
service after the backup/restore,
user domain conversion, and
registry export is complete.

None.WebView Installation

Guide2
Install the WebView
server(s) if not co-located
on the AW/HDS.

1 hour per
server

6

************************************************Start of
Central
Controller
Upgrade
Maintenance
Window

Routing is done by the
non-upgraded system.

Logger Technology
Refresh Upgrade: Side
A/B (page 85)

Upgrade the Side A
Logger.

1 hour + data
migration time

7

Both existing CallRouters are
duplexed.

The Logger is simplex.

Configuration changes are disabled.

The production system is running
simplex on Side B.

CallRouter Technology
Refresh Upgrade: Side
A/B (page 91)

Upgrade the Side A
CallRouter.

1 hour8

Default routing occurs from the
shutdown of the existing system

None.Bring down the
production system

1+ hours
depending on

9

until the new Side A CallRouter and
Logger are brought into service.

(CallRouters, Loggers,
and AWs), bring up the

number of PGs
and CIS
components

Historical and Real-time reporting
is provided by the previously

new Side A CallRouter
Logger, and
HDS/Distributor. Point

2) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsReferenceActionTime EstimateStep

the PGs and CIS
components to the new

upgraded HDS/Distributor AW
(step 5).

CallRouter and Logger in
the new domain. If a temporary release 5.0 or release

6.0 HDS/Distributor AW was in
use, it can be decommissioned at
this point.

Routing is simplex until the Side B
CallRouter is upgraded and brought
into service.

CallRouter Technology
Refresh Upgrade: Side
A/B (page 91)

Upgrade the Side B
CallRouter.

1 hour10

Configuration is enabled once the
Side B Logger is upgraded and
brought into service.

Logger Technology
Refresh Upgrade: Side
A/B (page 85)

Upgrade the Side B
Logger.

1 hour + data
migration time

11

************************************************End of
Central
Controller
Upgrade
Maintenance
Window

This can begin at any point after
step 9.

Distributor AW/HDS
Technology Refresh
Upgrade (page 70)

Upgrade the Side B
HDS/Distributor AW and
bring into service once
the upgrade is completed.

1 hour + data
migration time

12

None.Administrative
Workstation (AW)

Upgrade the AWs, PGs,
RMS, and CIS
components

1 hour per
node

13

Upgrade Procedures
(page 67)

PG Technology Refresh
Upgrade (page 100)

Remote Monitoring
System (RMS) Upgrade
Procedures (page 123)

CIS Upgrade Procedures
(page 117)

Common Ground Upgrade Examples

Common Ground Upgrade Example 1: Production HDS/Distributor AW Upgraded in Parallel with Central Controller

Two Common Ground upgrade examples are provided below. Both examples assume redundant
configurations with Side A and Side B CallRouters and Loggers, and that Side A and Side B
HDS/Distributor AWs are part of the system being upgraded and are required to support the
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number of reporting users. The examples therefore include the deployment of a temporary
HDS/Distributor AW to maintain maximum system functionality and reporting capacity during
the upgrade process.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

The deployment of a temporary HDS/Distributor AW may not be necessary depending on:

• the contact center hours of operation

• the estimated upgrade time for each ICM/IPCC node

• whether one or two HDS/Distributor AWs are deployed

• the reporting user capacity required during upgrade

• other operational factors

The temporary HDS/Distributor AW does not provide historical reporting, only real-time
reporting is provided. Both examples assume Side A is upgraded first, although the B side can
be upgraded first.

In the first example, the production HDS/Distributor AW is upgraded in parallel with the Central
Controller. If necessary, a release 7.0 temporary HDS/Distributor AW is configured prior to
the Central Controller upgrade maintenance window to enable real-time reporting and
configuration during the time that the production HDS/Distributor AW is off-line being upgraded.

Table 6: How to perform a CG upgrade where the production HDS/Distributor AW is upgraded in parallel with the Central

Controller Upgrade Maintenance Window:

CommentsReferenceActionTime EstimateStep

None.Baseline Requirements
(page 17)

Upgrade the production
system to the required
baseline.

None.1

No impact on the production
system.

Domain Conversion Tool
and Active Directory
(page 45)

Create the Active
Directory environment.

None.2

Required to enable configuration
and real-time reporting while the

Setting Up a Temporary
ICM/IPCC AW/HDS
(page 80)

Set up a temporary 7.0
HDS/Distributor AW.

1 hour3

Side A HDS/Distributor AW is
being upgraded.

************************************************Start of
Central
Controller
Upgrade
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CommentsReferenceActionTime EstimateStep

Maintenance
Window

Step 5 can begin as soon as the
EDMT is configured and running.

Distributor AW/HDS
Common Ground
Upgrade (page 78)

Upgrade the Side A
HDS/Distributor AW.

1 hour + data
migration time

4

Reporting is provided by the Side
B HDS/Distributor AW, although
reporting capacity is diminished
until the completion of both sides
of the Central Controller have been
upgraded and brought back on-line.

Routing done by non-upgraded
system.

Logger Common Ground
Upgrade: Side A/B (page
87)

Upgrade the Side A
Logger.

1 hour + data
migration time

5

Both existing CallRouters are
duplexed.

The Logger is simplex.

Configuration changes are disabled.

The production system is running
simplex on Side B.

CallRouter Common
Ground Upgrade: Side A
(page 92)

Upgrade the Side A
CallRouter.

1 hour6

None.WebView Installation

Guide3
Install the WebView
server(s) if not co-located
on the AW/HDS.

1 hour per
server

7

Default routing occurs from the
shutdown of the Side B CallRouter

None.

How to Bring Side A into
Service (page 93)

Bring down the side B
CallRouter, Logger, and
all distributor and Client
AWs.

1+ hours8

until the upgraded Side A
CallRouter and Logger are brought
into service.

None.Bring up the upgraded
Side A CallRouter and
Logger.

Real-time reporting is provided via
the temporary HDS/Distributor AW
set up in step 3.

Point the temporary
HDS/Distributor AW to Reporting capacity is diminished

until the Side A HDS/Distributor
AW is brought into service.

the upgraded Side A
CallRouter and Logger.

Routing is simplex until the Side B
CallRouter is upgraded and brought
into service.

CallRouter Common
Ground Upgrade: Side B
(page 95)

Upgrade the Side B
CallRouter.

1 hour9

Configuration is enabled once the
Side B Logger is upgraded and
brought into service.

Logger Common Ground
Upgrade: Side A/B (page
87)

Upgrade the Side B
Logger.

1 hour + data
migration time

10

3) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsReferenceActionTime EstimateStep

************************************************End of
Central
Controller
Upgrade
Maintenance
Window

This can begin at any point after
step 8.

Distributor AW/HDS
Common Ground
Upgrade (page 78)

Upgrade the Side B
HDS/Distributor AW.

1 hour + data
migration time

11

Historical and Realtime reporting
is available via the upgraded

None.Bring down the temporary
AW/HDS and then bring

Included in
time estimate
for Step 4.

12

AW/HDS once the upgraded
AW/HDS is brought on line.

up the upgraded AW/HDS
(or vice versa) when
available, at any point
after Step 8. Reporting capacity is still

diminished until the completion of
the upgrade of the B side AW/HDS
and it is brought back on-line.

The temporary HDS/Distributor
AW can be decommissioned once

None.Bring up the Upgraded
Side B HDS/Distributor
AW.

Included in
time estimate
for Step 12.

13

the Side B HDS/Distributor AW is
brought into service.

Full reporting functionality and
capacity is available at this point.

None.Administrative
Workstation (AW)

Upgrade the AWs, PGs,
RMS, and CIS
components.

1 hour per
node

14

Upgrade Procedures
(page 67)

Peripheral Gateway (PG)
Upgrade Procedures
(page 99)

Remote Monitoring
System (RMS) Upgrade
Procedures (page 123)

CIS Upgrade Procedures
(page 117)

Common Ground Upgrade Example 2: Production HDS/Distributor AW Upgraded Before the Central Controller
Upgrade Maintenance Window

In the second example, the production HDS/Distributor AW is upgraded before the Central
Controller upgrade maintenance window. If a secondary HDS/Distributor AW is not available,
a release 5.0 or release 6.0 temporary HDS/Distributor AW is set up to enable real-time reporting
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and configuration between the time that the Side A HDS/Distributor AW is upgraded and the
upgraded CallRouter, Logger, and Distributor AW are brought into service. Do not use this
option if maximum reporting capacity and functionality is required during upgrade, since the
intent is to upgrade the Side A HDS/Distributor AW well in advance of the Central Controller
upgrade maintenance window.

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this guide MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

Table 7: How to perform a CG upgrade on a system where the production HDS/Distributor AW is upgraded before the

Central Controller upgrade maintenance window:

CommentsReferenceActionTime EstimateStep

None.Baseline Requirements
(page 17)

Upgrade the production
system to the required
baseline.

None.1

No impact on the production
system.

Domain Conversion Tool
and Active Directory (page
45)

Create the Active
Directory environment.

None.2

Required to enable configuration
and real-time reporting until the

Setting Up a Temporary
ICM/IPCC AW/HDS
(page 80)

Set up temporary release
5.0 or release 6.0
HDS/Distributor AW.

1 hour3

upgraded CallRouter, Logger, and
HDS/Distributor AW are brought
into service.

If a Side B HDS/Distributor AW is
available and the reporting capacity
of two HDSs is not required, it is
not necessary to set up the
temporary HDS/Distributor AW.

Complete this step before the start
of the Central Controller upgrade
maintenance window.

Distributor AW/HDS
Common Ground Upgrade
(page 78)

Upgrade the Side A
HDS/Distributor AW.

1 hour + data
migration time

4

Reporting is provided by the Side
B HDS/Distributor AW and/or the
temporary HDS/Distributor AW.
If only a temporary AW/HDS is
available historical reporting will
not be available until after the
completion of the A side upgrade.

None.WebView Installation

Guide4
Install the WebView
server(s) if not
co-located on the
AW/HDS.

1 hour per
server

5

4) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsReferenceActionTime EstimateStep

************************************************Start of
Central
Controller
Upgrade
Maintenance
Window

Routing is done by the
non-upgraded duplexed
CallRouters.

Logger Common Ground
Upgrade: Side A/B (page
87)

Upgrade the Side A
Logger.

1 hour + data
migration time

6

The Logger is simplex.

Configuration changes are disabled.

The production system is running
simplex on Side B.

CallRouter Common
Ground Upgrade: Side A
(page 92)

Upgrade the Side A
CallRouter.

1 hour7

Default routing occurs from the
shutdown of the Side B CallRouter

None.

How to Bring Side A into
Service (page 93)

Bring down the side B
CallRouter, Logger, and
all distributor and client
AWs.

1+ hours
depending on
number of PGs
and CIS
components

8

until the upgraded Side A
CallRouter and Logger are brought
into service.

Bring up the upgraded
Side A CallRouter, Reporting is provided by the

previously upgraded Side A
HDS/Distributor AW.

Logger, and
HDS/Distributor AW.

If a temporary release 5.0 or release
6.0 HDS/Distributor AW was in
use, it can be decommissioned at
this point.

Routing is done by the upgraded
CallRouter and Logger - simplex.

Logger Common Ground
Upgrade: Side A/B (page
87)

Upgrade the Side B
Logger.

1 hour9

Configuration is enabled once the
Side B Logger is upgraded and
brought into service.

CallRouter Common
Ground Upgrade: Side B
(page 95)

Upgrade Side B
CallRouter.

1 hour + data
migration time

10

*************************************************End of
Central
Controller
Upgrade
Maintenance
Window

This can begin at any point after
step 8.

Distributor AW/HDS
Common Ground Upgrade
(page 78)

Upgrade the Side B
HDS/Distributor AW
and bring it into service

1 hour + data
migration time

11

once the upgrade is
completed.
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CommentsReferenceActionTime EstimateStep

None.Administrative
Workstation (AW)

Upgrade the AWs, PGs,
RMS, and CIS
components.

1 hour per
node

12

Upgrade Procedures (page
67)

Peripheral Gateway (PG)
Upgrade Procedures (page
99)

Remote Monitoring
System (RMS) Upgrade
Procedures (page 123)

CIS Upgrade Procedures
(page 117)

ICM/IPCC Component Upgrade Process

Following chapters provide information on the upgrade process for each major ICM/IPCC
component. The process assumes that most components are configured redundantly, typically
Side A and Side B. For ICM/IPCC 7.0(0), the database migration uses a process and tool called
the Enhanced Database Migration Tool (EDMT) (see Enhanced Database Migration Tool for
ICM/IPCC 7.0 (page 125)). This tool is referenced in the step-by-step procedures in this document.

Note:

• The phrase “ICM/IPCC core components” or “core components” refers to the following ICM
components: CallRouter, Logger, Administrator Workstations (AWs), Peripheral Gateways
(PGs), CTI Servers (CGs), CTI OS Servers, Historical Data Server (HDS), WebView Server.

• The phrase “ICM Central Controller” or “ICM Central Controller components” refers to the
following ICM components: CallRouter, Logger, key Distributor AW (with or without HDS,
HDS with or without WebView Server).
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Administrative Workstation (AW) Upgrade
Procedures

Introduction

There are four different types of Administrator Workstations (AWs) supported in ICM/IPCC
Release 7.0(0) deployments:

• Distributor AW with HDS and WebView Server (primary and secondary)

• Distributor AW with HDS without WebView Server (WebView Servers on dedicated
hardware)

• Distributor AW without HDS

• Client AW

In previous releases, WebView Servers were sometimes deployed on non-HDS Distributor
AWs. If this is the case, the WebView servers must be moved either onto AW/HDS, or on
separate servers.

The procedures for Distributor AW/HDSs, Non-HDS Distributor AWs, Client AWs, and creating
a temporary AW/HDS are presented in the following sections.

Note:

• It is only necessary to run the Domain Manager on the first component to be upgraded
(Distributor AW/HDS or Logger) to release 7.0(0) when adding that instance to the appropriate
Active Directory Instance organizational unit.

• Creating a temporary AW/HDS is required when real time reporting must remain available
during the upgrade of a system having a single HDS/WebView Server.
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Collocation of WebView server on a non-HDS AW is not supported for release 7.0. If WebView
is installed in on the non-HDS Distributor AW of the system being upgraded, the components
which make up WebView (Infomaker, ServletExec, EA Server, etc.) must be uninstalled before
beginning the upgrade.

Prior to creating an ICM 7.0(0) database, look up and record the size of your existing ICM
database.

AW/HDS/WebView Server Pre-upgrade Preparation

Pre-upgrade preparation is an integral part of the upgrade process. Perform the following on all
AW, HDS, and/or WebView servers to assist in recovery in the event of a catastrophic upgrade
failure:

Step 1 Perform a full SQL backup of the AW DB.

Step 2 Perform a full SQL backup of the ICM HDS DB.

Note: For ICM/IPCC 7.0(0) and later systems, there is a restriction on the number of HDSs that
can be configured on each Logger side, as well as the number of WebView servers that can be
configured for each HDS. Ensure there are no more than two (2) HDSs per Logger side, with
no more than four (4) WebView servers configured for each HDS. Refer to How to reduce the
number of HDSs (page 68) for additional information.

Step 3 Perform a full SQL backup of the WebView DB.

Step 4 Record the current size of the log files.

Step 5 Copy the Cisco registry key.

Step 6 Copy the ICM/bin directory.

Step 7 Copy the c:\winnt\awref.ini file.

How to reduce the number of HDSs

The following is for use on ICM/IPCC Release 7.0(0), and later, systems to reduce the number
of HDSs per Logger side to two (2) ,with up to four (4) WebView Servers configured for each
HDS.

The example following the steps illustrates this procedure.

Step 1 Select two (2) HDSs to keep per Logger side.

Step 2 Detach/remove all other HDSs from each Logger side.

Step 3 Remove the WebView server(s) from the remaining HDS(s).
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Step 4 Install the equivalent number of WebView servers as those removed.

Step 5 Configure the WebView servers to point to the appropriate HDS on each Logger side (with a
limit of four servers maximum configured to a single HDS).

Example:

Figure 2: Original Configuration

Figure 3: Select HDSs to Keep

Figure 4: Detach Remaining HDSs

Figure 5: Remove WebView Servers

Figure 6: Install and Point WebView Servers

How to remove pre-existing versions of EAServer (Jaguar)

Before you install EAServer. to be sure you are starting with a clean slate, you must uninstall
the previously installed versions of EAServer (Jaguar).

To remove any remnants of EAServer (Jaguar), perform the following steps and then re-run
setup:

Step 1 Stop the following services:

• IISAdmin

• Sybase EP Management Agent

• Jaguar

• sysam

Step 2 Close any open Services control panel windows.

Step 3 Close any windows with the title "Jaguar CTS Jaguar".
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Step 4 Run the file: c:\program
files\sybase\CIMRepository-3_0_0\bin\stoprepository.bat.

Step 5 Run the file: c:\Program Files\Sybase\AgentManager-3_0_0\bin\am_stop.bat.

Step 6 From a command prompt, execute the following command: %JAGUAR%\bin\serverstart.bat
-remove.

Step 7 From a command prompt, execute the following command: c:\Program
Files\Sybase\SYSAM-1_0\bin\installs.exe -n sysam -r.

Step 8 From a command prompt, execute the following command: c:\Program
Files\Sybase\shared-1_0\bin\sybjsvc.exe -d -sn"Sybase EP Management

Agent.

Step 9 Delete the entire c:\program files\sybase folder.

Step 10 Delete the folder c:\flexlm.

Step 11 Delete the registry key: HKEY_LOCAL_MACHINE\Software\Sybase.

Step 12 Delete the registry key: HKEY_LOCAL_MACHINE\Software\Sybase, Inc.

Step 13 Remove the following Environment Variables:

• Jaguar

• LM_LICENSE_FILE

• SYBASE_SYSAM

Step 14 Remove any references to the sybase folders from the PATH and CLASSPATH environment
variables.

Step 15 Reboot the computer.

Distributor AW/HDS Technology Refresh Upgrade

Upgrading the Primary/Secondary AW/HDS

Note:

• If WebView Server is to be collocated on the same server as the AW/HDS start at Step 1.

• If WebView Server is not to be collocated on the same server as the AW/HDS, start at Step
8.

Install IIS on the new AW/HDS. IIS is usually installed as part of the installation of Windows
2003. However, you can install IIS after installing Windows 2003. IIS must be installed IIS to
support WebView Browser functionality. You need to consider which server needs this
component. If you are going to install WebView on the AW/HDS then you must install IIS on
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the AW/HDS. If you are going to install WebView on a separate server then you must install
IIS on that server instead.

Note:

• Important: The Windows Firewall configuration scripts must be deployed before this server
can accept network connections. This must been done as part of the staging tasks.

• When installing IIS you will need files from the Windows 2003 CD.

Step 1 Install IIS after installing Windows 2003.

a. Click Start > Settings > Control Panel > Add/Remove Programs.

b. Select Configure Windows, click Components, and then follow the on-screen instructions
to install, remove, or add components to IIS.

c. Use the ICM/IPCC 7.0(0) Third Party Tools CD to install JDK, ServletExec, and EA
Server.

d. Print and read the Read Me file on the WebView 3rd Party Installer CD 7.0.

This file describes the software and provides installation instructions. Various settings described
in the Read Me file appear on certain setup screens.

Step 2 Install the WebView Third Party software.

a. Ensure that IIS is installed and is accessible on the system where WebView is being
installed. Third-party install fails if IIS is not installed.

b. Run setup.exe from the ICM Third Party Installer CD 7.0.

c. Reboot the server when setup completes.

d. Set the following to make sure that the cache is updated at each new view of a real-time
report:

• In the Internet Explorer window, select Tools > Internet Options.

• Select the General tab.

• On the General Settings tab page, in the Temporary Internet Files sections, click Settings.

e. In the Settings dialog box, enable the Every Visit to the Page option, then click OK.

f. Click OK in the Internet Options dialog box.

Note: WebView users are configured through the ICM Configuration Manager and passwords
default to a given expiration time frame set by the user's domain. If a WebView user's password
expires, the user cannot reset the password by WebView access, but would have to request that
the ICM System Administrator set a new password. Once the user is created, the ICM System
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Administrator has the option to set WebView User passwords to never expire through Active
Directory Users and Computers.

Step 3 Create a backup of the WebView database (wvdb) on the production AW/HDS using SQL
backup.

Step 4 Save any WebView public and/or private reports or favorites that exist on the production
AW/HDS, then copy them to the new AW/HDS. Move custom templates and saved reports
during a TR upgrade.

a. Before running ICM setup, create the folder path: \icm\<instance>\

b. For custom templates\aw\custom directory from the old machine to the new machine.

Step 5 Create the wvdb on the new AW/HDS using SQL Enterprise Manager (see How to create an
ICM database (page 145)).

When migrating from an older ICM/IPCC release to a newer ICM/IPCC release, you need to
lookup the database size of the existing ICM database. This number is used later in the process
to create an ICM database of the same size. This value may be increased depending on planned
ICM 7.0(0) usage patterns. To find the database size refer to How to Determine the Size of an
ICM Database (page 147).

The size and configuration of the tempdb database during data migration differs for the parameters
used in a production system. Set the tempdb size for each case (see How to set the tempdb
database size (page 148)).

Step 6 Restore the backup version of wvdb on the new AW/HDS using the MS SQL backup/restore
process.

Step 7 Prepare to move scheduled report jobs to the new WebView server:

a. Ensure the existing WebView server machine is on.

b. Ensure the new WebView server machine on.

c. Create a Windows account that has “Administrator” privileges on both the existing and
the new WebView server machines.

d. Confirm that “Task Scheduler” service is running on both machines by selecting Control
Panel > Administrative Tools > Services.

Step 8 Move scheduled report jobs to the new WebView Server.

a. Login to the existing WebView server machine using an account that has “Administrator”
privilege on both the existing and the new WebView server machines.

b. Select Control Panel > Scheduled tasks to open Scheduled Tasks.

c. From the available tasks, copy tasks related to WebView scheduled jobs.

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

72

Chapter 8: - Administrative Workstation (AW) Upgrade Procedures

Introduction



Note: WebView scheduled jobs can be identified by checking the “Run” command of each job.
WebView scheduled jobs have “scheduler.exe” in their run command. To check the “Run”
command of each job, select a job and open its properties.

d. Select and copy the jobs that need to be moved to new WebView machine.

e. Open Windows explorer and enter \\<New WebView machine name>. If prompted,
enter the login name and password of an account that has “Administrator” privileges on
the new machine.

f. In the explorer window, find the “Scheduled Tasks” item. Double-click and open Scheduled
Tasks on the target machine.

g. Paste the tasks copied from existing WebView server to new WebView server.

h. Verify that all WebView tasks are copied successfully.

i. WebView scheduled jobs start printing and/or saving reports on the new machine once:

• WebView is available on new machine

• WebView database has been restored from old WebView server to new WebView server

Step 9 Use the ICM/IPCC 7.0(0) data migration tool (EDMT) to migrate the HDS database from the
production AW/HDS to the new AW/HDS.

Note: Prior to installing the EDMT, prerequisites must be completed.

In the case of a Technology Refresh upgrade, EDMT must be installed and configured on the
new BOM (refer to the Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and
System Software Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/
sw/custcosw/ps1001/products_user_guide_list.html)) compliant destination database server
machine.

Refer to the indicated sections of this document, or the “How to ...” section of the EDMT online
help, for the details of each of the following tasks:

a. Perform the EDMT installation prerequisites (see How to perform the EDMT installation
prerequisites).

b. Install the EDMT (see How to install the EDMT (page 126)).

c. Run the EDMT (see How to run the EDMT (page 126)).
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d. Perform the EDMT Technology Refresh Migration - Side A (see Technology Refresh
Migration Sequence (page 129)).

• Select the Migration Version (see How to select the Migration Version).

• Select the Migration Type (see How to select the Migration Type).

• Click Next to continue to the Source and Destination Database Connection panels. Enter the
information required to connect to the migration source database server (see How to enter
the information required to connect to the migration source database server).

– Host Name/IP Address

– ICM Database Name

– SQL Server Port Number

– Windows Domain Name

– Windows Username

– Windows Password

e. Continue to the migration Destination Database Connection panel (see How to enter the
information required to connect to the migration destination database server).

Enter the information required to connect to the migration destination database server:

• Host Name/IP Address

• ICM Database Name

• SQL Server Port Number

• Windows Domain Name

• Windows Username

• Windows Password

f. Click Next to continue to the Backup Connection and Restore Location panels. Enter the
information required for EDMT to backup the migration source database (see How to enter
the information required for EDMT to backup the migration source database).

• Host Name/IP Address

• Windows Share Name

• Windows Share Username

• Windows Share Password
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g. Continue to the Restore Location panel and enter the restore location for the data file and
the log file (see How to enter the restore location for the data file and the log file).

• Data File Location

• Log File Location

h. Click Next to continue to the Migration Control panel. Click Start Migrationto begin the
data migration process. The following warning appears:

Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state and need to be restored from backup. Are you sure you
want to start the data migration?

Click Yes to start the data migration.

Click No to abort the data migration.

Select the appropriate choice.

Step 10 Export the ICM AW/HDS registry from the production AW/HDS, and import the registry to
the new AW/HDS.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 11 Import the saved ICM AW/HDS registry.

Note:

• Importing a registry file replaces portions of the registry. Do not import a registry file on the
existing production system. You can import the Cisco Systems, Inc. registry into the new
Windows 2003 system.

• Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 12 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new AW/HDS. Apply the automated
hardening when prompted.

Step 13 Using Domain Manager, add the AW/HDS instance to the appropriate Active Directory Instance
organizational unit.

Note: This step only needs to be run if it is the first component to be upgraded to release 7.0(0).

Step 14 From ICM setup, edit the instance by inserting the new domain name (select the OU created in
the previous step).

Step 15 From ICM setup, edit the AW component and make the necessary changes based on the
environment in which the new AW/HDS is to run.

Step 16 Edit the WebView component and make the necessary changes based on the environment in
which the new AW/HDS is to run.
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Note:

• If WebView was previously installed, the WebView component is also visible from ICM
setup.

• If WebView was not previously installed but is desired, install the WebView Third Party
software first, then add the WebView component. Enter the appropriate configuration data
when prompted.

Step 17 Using ICM Service Control, set all ICM processes on the new AW/HDS to Manual Start.

Step 18 Exit and then rerun setup.

Step 19 When the main setup screen appears, select Upgrade All.

Step 20 Reboot the AW/HDS.

Step 21 Run wvusersync.bat /update (located in the \ICM\web\webview\wvdb directory) on the
WebView server.

Step 22 Install the latest 7.0(0) Service Release and any required Engineering Specials on the new
AW/HDS.

Step 23 If required, re-execute the process to private label WebView.

Step 24 If the Outbound Option is in use and the Campaign Manager has been upgraded, open the
Campaign Manager configuration tool.

a. On the Call Target tab, configure the correct daylight savings time option for each
campaign.

b. On the Skill Group Selection tab, add a dialed number in the Dialed Number field for
each skill group selection entry in every campaign.

Step 25 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
AW/HDS.

Step 26 Start the upgraded Primary AW/HDS anytime after the previous step is completed and the Side
A Central Controller has been upgraded to and is running.

Exporting and Importing the Registry

Step 1 How to export a registry file

a. Open a command prompt and type regedit or select Start > Run, enter regedit. then
click OK.

b. Select HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc..

c. Click Registry > Export registry file.
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d. Browse the directory to determine where you want to export the registry file to.

e. Enter a filename to be remembered.

f. Click Save.

Step 2 How to import a registry file

a. Open a command prompt and type regedit or select Start > Run, enter regedit. then
click OK.

b. Select HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.

c. Click Registry > Import registry file.

d. Browse the directory to where the saved registry file is stored, then click Open.

e. Verify that the contents has been imported by looking at the entries under
HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.

f. Click Registry > Exit.

Terminating an In-progress Data Migration

If it becomes necessary to terminate an in-progress data migration, perform the following.

Step 1 Click Terminate Migration and Exit.

The following warning appears:

Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state and need to be restored from backup. Are you sure you
want to terminate the data migration?

Click Yes to terminate the migration process and exit the application.

Click No to continue the migration process.

Step 2 Select the appropriate choice.

Using the EDMT to Verify System Conditions

The EDMT can also be run on the new hardware in advance of the actual upgrade to verify the
following conditions:

• Connections to the source and destination databases are available

• The collation value for the source and destination databases is:
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– Latin1_General_BIN (for western/European languages -English, French, Spanish, German,
etc.)

– Japanese_BIN (for Japanese)

– Chinese_PRC_BIN (for Chinese)

– Korean_Wansung_BIN (for Korean)

– The source and destination databases are using the same collation value

• The operating system is Windows 2003

• SQL Server 2000 is installed

• The ICM schema for the source is correct

– 77 for ICM/IPCC Release 5.0(0)

– 84 for ICM/IPCC Release 6.0(0)

Step 1 Run the EDMT.

Step 2 Once these checks are made, an "Are You Sure" dialog box is presented. Since you are running
EDMT just to perform these checks, cancel out at this point.

If adequate disk space is not available, a temporary server must be configured to store the data
moved from the non-upgraded system. The temporary server does not need to have SQL Server
installed. Using a temporary database server results in increased data migration times because
the data is moved across the network twice instead of once. The temporary database server is
entered as the Backup Connection on Wizard Panel 3 as defined in EDMT. The upgrade
procedures and times in the sections which follow assume that a temporary server is not required.

When EDMT backs up the database from the production Logger or HDS, it stores the data in
one backup file, even if the data section of the database is broken up into separate data files
(data0, data1, data2, etc.), and/or the log section is broken up into separate files (log0, log1,
log2, etc.).

Each of the files could potentially be on separate logical or physical disk drives. EDMT only
allows one restore location, the desired ICM configuration, otherwise, the disk configuration
of the new hardware would have to exactly match the configuration of the original system and
may not make sense with newer hardware.

Distributor AW/HDS Common Ground Upgrade

Step 1 If not already done, using ICM Service Control, stop all ICM services on the AW/HDS.

Step 2 Using ICM Service Control, change all ICM services on the AW/HDS to Manual Restart.
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Step 3 Using third party imaging or “ghost” software, perform a full system backup of the AW/HDS
so that it can be restored if a critical failure occurs during the common ground upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Note: If you plan to change domains, do so at this point.

Step 5 Upgrade Third Party software such as virus protection software, VNC, and PC Anywhere.

Step 6 Reboot the AW/HDS.

Step 7 Install the Version 2.0 Support Tools agent.

Note: It is not necessary to uninstall older versions of the Support Tools agent.

Step 8 If WebView Server is collocated on the same server as the AW/HDS:

a. Remove Infomaker if it was previously installed. (In 7.0, Infomaker must be installed on
a separate, non-ICM machine).

b. Remove any pre-existing versions of EAServer (Jaguar).

c. Use the ICM 7.0 Third Party Tools CD to upgrade the JDK, ServletExec, and EA Server.

Step 9 Use the EDMT to update the HDS database to Release 7.0(0) (see Common Ground Migration
Sequence (page 139)).

Step 10 Using the Domain Manager, add the AW/HDS instance to the appropriate Active Directory
Instance organizational unit.

Note: This step only needs to be run if it is the first component to be upgraded to release 7.0(0).

Step 11 While in ICM setup, edit the AW and HDS components and review all entries.

Step 12 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the AW/HDS. When the main setup
screen appears, click Upgrade All.

Step 13 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name.

Step 14 Reboot the AW/HDS.

Step 15 Install the latest 7.0 Service Release and any required Engineering Specials on the AW/HDS

Step 16 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
AW/HDS.
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Setting Up a Temporary ICM/IPCC AW/HDS

Based on the upgrade you are performing, you can create a temporary ICM/IPCC AW/HDS to
provide reporting during the upgrade process. You may need to create a temporary AW/HDS
for either the existing ICM/IPCC 5.0(0)/6.0(0) system or for the new ICM/IPCC 7.0(0) system.
The maintenance windows discussed below correspond to those in the Figure 1: Upgrading a
Complex, Multi-media, ICM/IPCC System (page 24).

Setting Up a Temporary ICM/IPCC AW/HDS for an ICM/IPCC 5.0(0) or an ICM/IPCC 6.0(0) System

Create a temporary ICM/IPCC 5.0(0) or 6.0(0) AW/HDS if you are starting with only a Primary
AW/HDS to provide reporting. During the first maintenance window, while you upgrade side
A and the Primary AW/HDS, the temporary AW/HDS provides real time and historical reporting,
getting data from side B.

In the second maintenance window, side A is now upgraded and coming up, side B is down
being upgraded, and no ICM/IPCC 7.0(0) AW is available. This results in no reporting
capabilities in the second maintenance window until the Primary AW/HD is upgraded and back
up.

Step 1 Run ICM setup on either a new machine or an existing machine that will not be upgraded during
the first maintenance window.

Step 2 Using ICM setup, create an AW/HDS component on the existing ICM/IPCC 5.0(0) or ICM/IPCC
6.0(0) system.

Step 3 Upgrade the rest of the existing system using the appropriate procedure from the Upgrade
Procedures section of this guide.

Setting Up a Temporary ICM/IPCC AW/HDS for an ICM/IPCC 7.0(0) System

Create a temporary ICM/IPCC 7.0(0) AW/HDS if you are starting with both a Primary and a
Secondary AW/HDS to provide reporting. During the first maintenance window, while you
upgrade side A and the Primary AW/HDS, the Secondary AW/HDS provides real time and
historical reporting, getting data from side B.

In the second maintenance window, the upgraded side A is coming up, side B is down being
upgraded. The temporary ICM/IPCCC 7.0(0) AW/HDS provides real time reporting only, getting
data from the upgraded side A. Normal reporting (real time and historical) is restored when the
Primary AW/HDS is upgraded to ICM/IPCC 7.0(0) and is up and running.

Step 1 Run ICM setup on new BOM compliant hardware.

Step 2 Perform a fresh installation of an ICM/IPCC 7.0(0) AW/HDS.
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Step 3 Point the new ICM/IPCC 7.0(0) AW/HDS to the ICM/IPCC 7.0(0) Logger and CallRouter.

Step 4 Upgrade the Logger to ICM/IPCC 7.0(0).

Step 5 Upgrade the CallRouter to ICM/IPCC 7.0(0).

Step 6 Bring up the ICM/IPCC 7.0(0) Logger and CallRouter.

Step 7 Bring down all the other ICM/IPCC 7.0(0) components.

Step 8 Bring up the new ICM/IPCC 7.0(0) AW/HDS

Step 9 Upgrade the rest of the existing system using the appropriate procedure from the Upgrade
Procedures section of this guide.

Non-HDS Distributor AW Technology Refresh Upgrades

Step 1 If not already done, stop the ICM services on the production distributor AW using the ICM
Service Control.

Step 2 Export the ICM AW registry from the production AW, and import the registry to the new AW.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 3 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new AW. Apply the automated
hardening when prompted.

Step 4 From ICM setup, edit the instance and insert the new domain name.

Step 5 From ICM setup, edit the AW component and make the necessary changes based on the
environment in which the new Logger is to be run. For ICM/IPCC 7.0(0), make sure WebView
is not checked since WebView Server is not supported on a non-HDS distributor AW.

Step 6 Using ICM Service Control, set all ICM processes on the new AW to Manual Start.

Step 7 Exit and then rerun setup. When the main setup screen appears, select Upgrade All.

Step 8 Reboot the AW.

Step 9 Install the latest ICM/IPCC 7.0(0) service releases and any required engineering specials on the
new AW.

Step 10 If the Outbound Option is in use and the Campaign Manager has been upgraded, open the
Campaign Manager configuration tool.

a. On the Call Target tab to configure the correct daylight savings time option for each
campaign.

b. On the Skill Group Selection tab, add a dialed number in the Dialed Number field for
each skill group selection entry in every campaign.
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Step 11 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new AW.

Non-HDS Distributor AW Common Ground Upgrades

Step 1 If not already done, using ICM Service Control, stop all ICM services on the AW

Step 2 Using ICM Service Control, change all ICM services on the AW to Manual Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the AW server
so that it can be restored if a critical failure occurs during the common ground upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Note: If you plan to change domains, do so at this point.

Step 5 Upgrade Third Party software such as virus protection software, VNC, or PCAnywhere.

Step 6 Reboot the AW.

Step 7 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 8 Using the Domain Manager, add the AW instance to the appropriate Active Directory Instance
Organizational Unit.

Step 9 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the AW.

Step 10 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the AW.

Step 11 While in ICM setup, edit the AW component and review all entries.

Step 12 Reboot the AW.

Step 13 Install the latest 7.0 service release and any required engineering specials on the updated
CallRouter.

Step 14 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the upgraded
CallRouter.

Client AW Technology Refresh Upgrades

Step 1 Set up the new server as outlined in Set up the New Hardware.

Step 2 Using the ICM Service Control, stop all ICM services on the production AW being replaced.
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Step 3 Export the ICM registry from production Client AW, and import the registry to the new Client
AW.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 4 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new AW.

Step 5 From ICM setup, edit all instances on the new server and insert the new domain name.

Step 6 From ICM setup, edit all ICM components on the new server and make the necessary changes
based on the environment in which the new AW is to run.

Step 7 Exit and then rerun setup. When the main setup screen appears, select Upgrade All.

Step 8 Using ICM Service Control, set the ICM processes on the new AW to Manual Start.

Step 9 Reboot the new AW .

Step 10 Install the latest ICM/IPCC 7.0(0) services release and any required engineering specials on the
new AW.

Step 11 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new AW.

Step 12 Using ICM Service Control, start the ICM processes on the new AW.

Step 13 Using ICM Service Control, set the ICM processes on the new AW to Automatic Start.

Client AW Common Ground Upgrade

Step 1 Using ICM Service Control, stop all ICM services on the AW.

Step 2 Using ICM Service Control, change all ICM services on the AW to Manual Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the AW server
so that it can be restored if a critical failure occurs during the common ground upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Note: If you plan to change domains, do so at this point.

Step 5 Upgrade Third Party software such as virus protection software, VNC, or PCAnywhere.

Step 6 Reboot the AW.

Step 7 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 8 Using the Domain Manager, add the AW instance to the appropriate Active Directory Instance
Organizational Unit.
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Step 9 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the AW.

Step 10 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the AW.

Step 11 While in ICM setup, edit the AW component and review all entries.

Step 12 Reboot the AW.

Step 13 Install the latest 7.0 Services Release and any required Engineering Specials on the AW.

Step 14 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the AW.

Installing WebView Server(s) Not Collocated on the AW/HDS

For additional information refer to the WebView Installation and Administration Guide
forWebView Installation and Administration Guide for Cisco ICM/IPCC Enterprise &
Hosted Editions, Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)  (http://
www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm).

Note: Important: The Windows Firewall configuration scripts must be deployed before this
server can accept network connections. This is done as part of the staging tasks.
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Logger Upgrade Procedures

Logger Pre-upgrade Preparation

Pre-upgrade preparation is an integral part of the upgrade process. Perform the following on
the Logger to assist in recovery in the event of a catastrophic upgrade failure:

Step 1 Perform a full SQL backup of the ICM DB.

Step 2 Perform a full SQL backup of the Outbound DB if applicable.

Step 3 Record the current size of the log files.

Step 4 Copy the Cisco registry key.

Step 5 Copy the ICM/bin directory.

Logger Technology Refresh Upgrade: Side A/B

The following procedure is used to perform a Technology Refresh upgrade on both sides of the
Logger. When upgrading Side A use the procedure as is. When upgrading Side B, simply replace
“Side A” with “Side B” in the procedure.

Note: Important: The Windows Firewall configuration scripts must be deployed before this
server can accept network connections. This is done as part of the staging tasks.

How to perform a TR upgrade on the Logger

1. Disable configuration changes.
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– Set the HKEY_LOCAL_MACHINE\Software\Cisco Systems,
Inc.\ICM\<instancename>\RouterA\Router\CurrentVersion\Configuration\Global\DBMaintenance
key to 1 on both sides of the CallRouter in the system being upgraded.

Note: RouterA in the registry key above is RouterB on the Side B CallRouter.

– Verify that configuration changes are prevented. The following message is displayed
when attempting to save a configuration change:

Failed to update the database. Exclusive access to the CallRouter denied because
configuration changes are currently disabled in the router registry.

2. Using the ICM Service Control, stop the ICM services on the Side A production Logger,
Distributor AW, and HDS.

3. If the Outbound Option is in use, back up the Outbound Option private database using the
SQL Server Enterprise Manager. The campaign manager is present on only one of the
redundant Loggers, and needs to be upgraded on only that Logger.

Note:

• Dialers and their associated PG must be upgraded to Version 7.0 for proper
outbound option operation.

• In order to support sequential dialing, and 10 telephone numbers per contact, the
outbound option database has changed significantly, and requires you to re-import
the campaign lists.

4. Create the Outbound Option database (if required) on the new Logger using SQL Enterprise
Manager (see How to create an ICM database (page 145)).

5. Use the EDMT to migrate the Logger database from the production Logger to the new
Logger.

6. Export the ICM Logger registry from the production Logger, and import the registry to
the new Logger.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

7. Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new logger. Choose to apply
the automated hardening when prompted.

8. Using Domain Manager, add the Logger instance to the appropriate Active Directory
Instance organizational unit.
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Note: This step only needs to be run if it is the first component to be upgraded to release
7.0(0).

9. From ICM setup, edit the instance by inserting the new domain name (select the OU created
in the previous step).

10. From ICM setup, edit the Logger component and make the necessary changes based on
the environment in which the new Logger is to run.

11. Exit and then rerun setup. When the main setup screen appears, select Upgrade All.

12. Using ICM Service Control, set all ICM processes on the new Logger to Manual Start.

13. Reboot the Logger.

14. Run the Domain Conversion tool to migrate users from the production system to the new
environment.

For additional information, refer to the Staging Guide, ICM/IPCC Enterprise/Hosted,
ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/univercd/cc/td/doc/product/
icm/icmentpr/icm70doc/microsf7/index.htm)

15. Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials
on the new Logger.

16. If the Outbound Option is in use, re-import the customer contact lists and do-not-call lists
(on the Side A or Side B Logger only).

Note: The dialers and their associated PG must be upgraded to Version 7.0 for proper
Outbound Option operation.

17. Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
Logger.

Logger Common Ground Upgrade: Side A/B

Note: The following procedure is used to perform a Common Ground upgrade on both sides
of the Logger. When upgrading Side A use the procedure as is. When upgrading Side B, simply
replace “Side A” with “Side B” in the procedure.

Step 1 Disable configuration changes.

a. Set the HKEY_LOCAL_MACHINE\Software\Cisco Systems,
Inc.\ICM\<instancename>\RouterA\Router\CurrentVersion\Configuration\Global\DBMaintenance
key to 1 on both sides of the CallRouter in the system being upgraded.

Note: RouterA in the registry key above is RouterB on the Side B CallRouter.

b. Verify that configuration changes are prevented. The following message is displayed when
attempting to save a configuration change:
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Failed to update the database. Exclusive access to the CallRouter denied because configuration
changes are currently disabled in the router registry.

Step 2 Using ICM Service Control, stop all ICM services on the Side A Logger, Distributor AW, and
HDS.

Step 3 Using ICM Service Control, set all ICM services on the Side A Logger, Distributor AW, and
HDS to Manual Restart.

Step 4 Using third party imaging or “ghost” software, perform a full system backup of the Side A
Logger so that it can be restored if a critical failure occurs during the Common Ground upgrade
process.

Step 5 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Step 6 Upgrade the Third Party Software such as virus protection software and VNC, or PC Anywhere.

Step 7 Reboot the Side A Logger.

Step 8 Install the Version 2.0 Support Tools agent.

Note: It is not necessary to uninstall older versions of the Support Tools agent.

Step 9 If the Outbound Option is in use, back up the Outbound Option private database using the SQL
Server Enterprise Manager. The campaign manager is present on only one of the redundant
Loggers, and needs to be upgraded on only that Logger.

Note:

• Dialers and their associated PG must be upgraded to Version 7.0 for proper outbound option
operation.

• In order to support sequential dialing, and 10 telephone numbers per contact, the outbound
option database has changed significantly, and requires you to re-import the campaign lists.

Step 10 Use the EDMT to migrate the Logger database.

Refer to Technology Refresh Migration Sequence (page 129) for additional information.

Step 11 Using the Domain Manager, add the Logger instance to the appropriate Active Directory Instance
Organizational Unit.

Note: This step only needs to be run if it is the first component to be upgraded to release 7.0(0).

Step 12 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the Logger. When the main setup screen
appears, select Upgrade All.

Step 13 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the Side A Logger.

Step 14 While in ICM setup, edit the Logger component and review all entries
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Step 15 Reboot the Logger.

Step 16 If necessary (for example, the domain changed), run the Domain Conversion tool to migrate
users to the new environment.

For additional information, refer to the Staging Guide, ICM/IPCC Enterprise/Hosted,
ICM/IPCC Software Release 7.0(0)  (http://www.cisco.com/en/US/products/sw/custcosw/
ps1001/prod_installation_guides_list.html)

Step 17 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
new Logger.

Step 18 If the Outbound Option is in use, re-import the customer contact lists and do-not-call lists (on
the Side A or Side B Logger only).

Note: The dialers and their associated PG must be upgraded to Version 7.0 for proper Outbound
Option operation.

Step 19 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new Logger.
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CallRouter Upgrade Procedures

CallRouter Pre-upgrade Preparation

Pre-upgrade preparation is an integral part of the upgrade process. Perform the following on
the CallRouter to assist in recovery in the event of a catastrophic upgrade failure:

Step 1 Copy the Cisco registry key.

Step 2 Copy the ICM/bin directory.

CallRouter Technology Refresh Upgrade: Side A/B

Note: The following procedure is used to perform a Technology Refresh upgrade on both sides
of the Logger. When upgrading Side A use the procedure as is. When upgrading Side B, simply
replace “Side A” with “Side B” in the procedure.

Step 1 Export the ICM router registry from the production CallRouter, and import the registry to the
new CallRouter.

Step 2 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new CallRouter. Choose to apply the
automated hardening when prompted.

Step 3 From ICM setup, edit the instance and insert the new domain name on the new CallRouter.

Step 4 From ICM setup, edit the CallRouter component and make the necessary changes based on the
environment in which the new CallRouter is to be run.

Step 5 Using ICM Service Control, set all ICM processes on the new CallRouter to Manual Start.
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Step 6 Exit and then rerun setup. When the main setup screen appears, select Upgrade All.

Step 7 Reboot the new CallRouter.

Step 8 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
new CallRouter.

Step 9 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
CallRouter.

Step 10 Upgrade any Network Gateways associated with NICs on the CallRouter. See Network Gateway
Upgrades (page 111) for detailed instructions.

Note:

• DOS NICs are not supported by ICM/IPCC Release7.0(0).

• Important: The Windows Firewall configuration scripts must be deployed before this server
can accept network connections. This is done as part of the staging tasks.

CallRouter Common Ground Upgrade: Side A

Note: The following procedure is used to perform a Common Ground upgrade on both sides
of the CallRouter. When upgrading Side A use the procedure as is. When upgrading Side B,
simply replace “Side A” with “Side B” in the procedure .

Step 1 Using ICM Service Control, stop all ICM services on the Side A CallRouter.

Step 2 Using ICM Service Control, change all ICM services on the Side A CallRouter to Manual
Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the side A
CallRouter server so that it can be restored should a critical failure occur during the common
ground upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Step 5 Upgrade the Third Party Software such as virus protection software and VNC, or PC Anywhere.

Step 6 Reboot the Side A CallRouter.

Step 7 Install the Version 2.0 Support Tools agent.

It is not necessary to uninstall older versions of the Support Tools agent.

Step 8 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the Side A CallRouter.

Step 9 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance, and insert the new domain name on the Side A CallRouter.
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Step 10 While in ICM setup, edit the CallRouter component and review all entries.

Step 11 Reboot the Side A CallRouter.

Step 12 Install the latest 7.0 services release and any required engineering specials on the new CallRouter.

Step 13 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
CallRouter.

Step 14 Upgrade any Network Gateways associated with NICs on the CallRouter. See Network Gateway
Upgrades (page 111) for detailed instructions.

Note: DOS NICs are not supported by ICM/IPCC Release7.0(0).

How to Bring Side A into Service

Once the steps outlined in the Administrative Workstation (AW) Upgrade Procedures (page
67), Logger Technology Refresh Upgrade: Side A/B (page 85), and CallRouter Technology
Refresh Upgrade: Side A/B (page 91) are completed, follow the steps below to bring the ICM
Side A Central Controller components into service:

Step 1 All components can “ping” public and private IP addresses as applicable to verify network
connectivity between the upgraded ICM central controller components, but not to other ICM
nodes in production. Shut down all non-upgraded AWs and the Side B CallRouter and Logger
by stopping the ICM services on these components using ICM Service Control. Start the upgraded
side.

Step 2 Using the ICM Service Control, manually start the ICM services on the Side A CallRouter and
Logger, and the upgraded AW. Verify the basic operation of the Side A Central Controller
components:

• General

– Setup logs indicate no errors or failure conditions

– AD domain has all users

– Schema upgrade is successful for all databases (no loss of data integrity, or loss of data)

– Registry changes are correct and match what is documented in setup logs

– All component services start without errors

– All general activities (accessing SQL Server, running third party software components
like VNC or PCAnywhere, etc. are not stopped by CSA)

– Calls are successfully processed

• CallRouter
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– Ccagent is in service but not connected to any peripheral gateways

– Rtsvr is connected to the Primary AW

• Logger

– Recovery process not required, no activity other than process start up

– Users are in correct domain

– Configuration information is passed to CallRouter

– Replication process begins when HDS comes online

• HDS

– AW indicates it is waiting for work

– Replication process begins with no errors

• Security

– Specified users are able to use configuration manager

– Specified users are able to log in to WebView and can access both public and private
reports (all previously existing reports are present)

• Script Editor

– Users previous settings are present when application is opened

– Validate All script yields same results as pre-upgrade test yielded

– Scripts can be opened, edited, deleted or new scripts can be created

• ICMDBA

– Import/Export functionality is present

– Database space allocation and percent used are correct

• Support Tools

– Can acquire logs, capture registry information, schedule collection of logs

Step 3 Using ICM Service Control, set the ICM services to Autostart on each of the upgraded ICM
components.

Warning: Call processing is impacted until the next 3 steps are completed, and therefore
they must be executed at an appropriate pre-planned time.

Step 4 Using the ICM Service Control, stop the ICM Services the Side B Logger and the Side B
CallRouter, and all AWs.
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Step 5 Configure all other ICM components (PGs, gateways, NAMs, CICMs, multi-media components)
to connect to the upgraded Side A Logger and Side A CallRouter.

Step 6 Using the ICM Service Control, start the ICM services on the upgraded Side A Logger, and
Side A CallRouter. Start the ICM processes on the AW/HDS once its upgrade process is complete
at any point at or after this step.

Step 7 Verify production system operation running with the upgraded Side A CallRouter and Side A
Logger.

CallRouter Common Ground Upgrade: Side B

Repeat the steps in CallRouter Technology Refresh Upgrade: Side A/B (page 91) on the Side
B CallRouter.

Note:

• Important: The Windows Firewall configuration scripts must be deployed before this server
can accept network connections. This is done as part of the staging tasks.

• DOS NICs are not supported by ICM/IPCC Release 7.0(0).

Verify the basic operation of the B Side CallRouter and Side B Logger

Step 1 Manually synchronize Logger B to Logger A (with B being the last to be upgraded and before
bringing it online) using ICMDBA.

Step 2 Start the side B CallRouter and Logger services.

Each service starts several process windows on the task bar of the local machine, each one an
ICM program associated with the service. As each node starts up, it looks for the other server
components and attempts to register with them. If you completed the ICM Setup and network
testing successfully, no major errors should occur.

In order to add configuration data, the Central Controller and Admin Workstation(s) must be
running. The ICM software loads an ICM Service Control tool on the desktop of each server
used to control the services loaded on that machine.

Verify that the ICM Processes have no errors.

• CallRouters

– Router: UP and synchronized with peer.

– Ccagent: [In service, but not connected to any peripheral gateways.]
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– Rtsvr: [no connectivity to AW at this time.]

• Loggers

– Logger: Connected to its respective database and synchronized with peer. MDS is in
service.

– Replication: [No connectivity to AW HDS at this time.]

– Campaign Manager: [You see errors, no BA Dialer setup at this time.]

Step 3 Start AW (Distributor) Services

Start the Distributor Service within Cisco Service Control. Verify that the ICM Processes have
no errors.

CallRouters

• Router: UP and synchronized with peer.

• Ccagent: [In service but not connected to any peripheral gateways.]

• Rtsvr: [Feed activated to AW.]

Loggers

• Logger: Connected to its respective database and synchronized with peer. MDS is in service.

• Replication: Connected to the AW.

• Campaign Manager: [You see errors, no BA Dialer setup at this time.]

Admin Workstation

• Updateaw: Displays "waiting for new work".

• Iseman: Listen thread waiting for client connection.

• Replication: Replication and recovery client connection initialized.

• Cms_jserver: Unable to initialize until the configuration is done.

• Cmsnode: Shutdown in progress, terminating.

Step 4 Settings for Production Environment

Validate the following settings from the system diagram for the Production Environment and
make the required changes prior to placing the systems in production:

a. Clear Event logs.
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b. Clear any Dr. Watson application errors.

c. Remove any diskettes, CD's or media from drives.

d. Make sure that all ICM Services are set to Manual Start. Services are not set to Autostart
until after the implementation testing in the production environment.

Step 5 Using ICM Service Control, set the ICM services to Autostarton the upgraded Side B CallRouter
and Logger.

Step 6 Using ICM Service Control, start the ICM services on the new Side B CallRouter and Logger.

If possible, once data synchronization is complete between the Loggers, cycle the ICM services
on the Side A CallRouter and Side A Logger and verify that the Side B takes over and that the
system continues to operate normally.

Step 7 Verify overall system operation.

Step 8 Enable configuration changes.

a. Set the HKEY_LOCAL_MACHINE\Software\Cisco Systems, Inc.\ICM\<instance
name>\RouterA\Router\CurrentVersion\Configuration\Global\DBMaintenance key to 0
on the Side A and Side B CallRouters of the system being upgraded.

Note: RouterA in the registry key above is RouterB on the Side B CallRouter.

b. Verify that configuration changes are possible.

Step 9 If the Outbound Option is in use, upgrade all Outbound Option dialers and their associated PGs
per the procedures in Peripheral Gateway (PG) Upgrade Procedures (page 99).

Step 10 Upgrade any other Distributor AWs and/or HDSs using the steps documented in Administrative
Workstation (AW) Upgrade Procedures (page 67).
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Peripheral Gateway (PG) Upgrade Procedures

PG Pre-upgrade Preparation

Pre-upgrade preparation is an integral part of the upgrade process. Perform the following on all
PGs to assist in recovery in the event of a catastrophic upgrade failure:

Step 1 Copy the Cisco registry key.

Step 2 Copy the ICM/bin directory.

Upgrading PGs

While different Peripheral Gateways (PGs) can be upgraded at different times, the A and B side
of redundant PG pairs must be upgraded within the same maintenance window, along with
associated CTI Servers, CTI OS servers, and Outbound Option dialers. For proper Outbound
Option operation, all Outbound Option dialers must be upgraded during the same maintenance
window as the Campaign Manager.

If a CAD version prior to 4.6 is connected to the PG being upgraded, both the CAD server and
the associated CAD desktops must first be upgraded to a version compatible with ICM/IPCC
7.0(0). CAD Version 7.0 requires CTI OS version 7.0. CAD Version 6.0 requires CTI OS
Version 6.0, but versions of CAD prior to 6.0 do not require CTI OS.

For CallManager PGs and Generic PGs with CallManager PIMs, CallManager clusters must
be upgraded to Version 4.0 or 4.1 prior to upgrading the PG to ICM/IPCC Release7.0(0).
CallManager PGs must remain at release 5.0(0) or 6.0(0) if CallManager version 3.3 is in use.
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Versions of CallManager earlier than 3.3 are not supported by ICM/IPCC release 7.0(0). IP
IVRs associated with the CallManager must also be upgraded to a compatible version.

ICM/IPCC 7.0(0) introduces a new PG type, called the IPCC System PG. In ICM/IPCC 7.0(0),
this PG supports a CallManager PIM and multiple VRU PIMs while appearing as a single
peripheral to the ICM. There is no automated upgrade to the IPCC System PG model from a
system using separate CallManager and VRU PGs, or a system using a Generic PG with
CallManager and VRU PIMs.

ICM/IPCC 7.0(0) can operate with PGs at ICM release 5.0(0) or 6.0(0), but only during the
upgrade process. CallManager PGs at ICM release 5.0(0) or 6.0(0) that support CallManager
3.3 are the exception.

The Version of CTI OS must be aligned with the PG version:

• PGs at ICM release 5.0(0) require CTI OS version 5.0 or version 5.1 (best choice).

• PGs at ICM release 6.0(0) require CTI OS version 6.0.

• PGs at ICM release 7.0(0) require CTI OS version 7.0.

You must upgrade PGs and CTI OS server to ICM release 5.0(0), ICM release 5.1(0) for CTI
OS, or ICM release 6.0(0) before the upgrade to ICM release 7.0(0), since no direct upgrade
path to ICM release 7.0(0) is supported.

This document assumes that if CTI Gateways (CGs) are in use, they are collocated on the same
server as the PG. The CTI Gateway primary process is the CTI Server. The CTI OS Server is
a separate component, and may be collocated, or on a separate server from the PG.

PG Technology Refresh Upgrade

Step 1 Set up the new Side A and Side B PG servers as outlined in Setting up the Hardware (page 35).

Step 2 Using the ICM Service Control, stop all ICM and CTI OS services on the Side A production
PG.

Step 3 Export the ICM registry from production PG, and import the registry to the new PG.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 4 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new side A PG. Choose to apply the
automated hardening when prompted.

Step 5 From ICM setup, edit all instances on the new server and insert the new domain name.

Step 6 From ICM setup, edit all ICM components (PG, dialer, and CTI Server) on the new server and
make the necessary changes based on the environment in which the new PG is to run.

Step 7 Exit and then rerun setup. When the main setup screen appears, select Upgrade All.
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Step 8 If CTI OS server is to be installed on the same server as the PG, run setup on the CTI OS 7.0
CD to install the CTI OS server. Input the appropriate domain name and other configuration
elements as they apply to the new environment.

Step 9 If this is a CallManager PG or a Generic PG with a CallManager PIM, upload the JTAPI Client
from CallManager.

How to Install the Cisco JTAPI Client on the Generic IPCC PG

The Cisco JTAPI Client is a Java Telephony Application Programming Interface implementation
that communicates with the Cisco CallManager.

After installing the Generic IPCC PG, you must install the Cisco JTAPI Client so that the PG
can communicate via JTAPI with Cisco CallManager. You install the Cisco JTAPI Client from
Cisco CallManager Administration.

a. Open a browser window on the PG machine.

b. Enter the URL for the CallManager Administration utility: http://<CallManager machine
name>/ccmadmin.

c. Enter the user name and password that you created when installing and configuring Cisco
CallManager (Lab Value: cm_pg_user).

d. Choose Application > Install Plug-ins.

e. Click the icon next to Cisco JTAPI. A File Download box opens.

f. Choose Run this program from its current location. Click OK.

g. On the Security Warning box, click Yes to install.

h. Choose Next or Continue through the remaining Setup screens. Accept the default
installation path.

i. Click Finish.

j. Reboot the machine to ensure proper operation of JTAPI.

For additional information, refer to IPCC Installation and Configuration Guide for Cisco
IPCC Enterprise Edition, Cisco IPCC Enterprise Edition Release 7.0(0)  (http://
www.cisco.com/univercd/cc/td/doc/product/icm/ipccente/ipcc70d/ipcccor7/index.htm)

Step 10 Using ICM Service Control, set the ICM and CTI OS processes on the new Side A PG to Manual
Start.

Step 11 Reboot the PG.

Step 12 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
new PG.

Step 13 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new PG.
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Step 14 If there are Outbound Option dialers associated with the PG pair being upgraded which are on
separate servers, upgrade all of them now.

PG Common Ground Upgrade

Step 1 Using ICM Service Control, stop all ICM and CTI OS services on the Side A PG.

Step 2 Using ICM Service Control, change all ICM and CTI OS services on the Side A PG to Manual
Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the side A
Peripheral Gateway server so that it can be restored should a critical failure occur during the
common ground upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Step 5 Upgrade Third Party software such as virus protection software and VNC or PC Anywhere.

Step 6 Reboot the Side A PG.

Step 7 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 8 Using the Domain Manager, add the PG instance to the appropriate Active Directory Instance
Organizational Unit.

Step 9 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the Side A PG.

Step 10 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the Side A PG.

Step 11 While in ICM setup, edit the PG component and review all entries.

Step 12 If CTI OS is collocated on the same server as the PG, run setup.exe from the CTI OS 7.0 CD
to install 7.0 CTI OS on side A. It is not necessary to uninstall previous versions of CTI OS.

Step 13 If this is a CM PG or a Generic PG with a CallManager PIM, upload the JTAPI Client from
CallManager.

How to Install the Cisco JTAPI Client on the Generic IPCC PG

The Cisco JTAPI Client is a Java Telephony Application Programming Interface implementation
that communicates with the Cisco CallManager.

After installing the Generic IPCC PG, you must install the Cisco JTAPI Client so that the PG
can communicate via JTAPI with Cisco CallManager. You install the Cisco JTAPI Client from
Cisco CallManager Administration.

a. Open a browser window on the PG machine.
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b. Enter the URL for the CallManager Administration utility: http://<CallManager machine
name>/ccmadmin.

c. Enter the user name and password that you created when installing and configuring Cisco
CallManager (Lab Value: cm_pg_user).

d. Choose Application > Install Plug-ins.

e. Click the icon next to Cisco JTAPI. A File Download box opens.

f. Choose Run this program from its current location. Click OK.

g. On the Security Warning box, click Yes to install.

h. Choose Next or Continue through the remaining Setup screens. Accept the default
installation path.

i. Click Finish.

j. Reboot the machine to ensure proper operation of JTAPI.

For additional information, refer to IPCC Installation and Configuration Guide for Cisco
IPCC Enterprise Edition, Cisco IPCC Enterprise Edition Release 7.0(0)  (http://
www.cisco.com/univercd/cc/td/doc/product/icm/ipccente/ipcc70d/ipcccor7/index.htm)

Step 14 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
Side A PG.

Step 15 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the Side A
PG.

Step 16 If there are Outbound Option dialers associated with the PG pair being upgraded which are on
separate servers, upgrade all of them now.

Upgrading Outbound Option Dialers

Because of the added capability and increased number of contacts supported by the Outbound
Option in ICM/IPCC Release 7.0(0), it is necessary to re-import the contact and do-not call lists
when upgrading.

Information regarding which contacts have been called and which are yet to call on in-process
outbound campaigns is lost during the upgrade, so the timing of the upgrade must be planned
accordingly. In addition, the Outbound Option dialers and their associated PGs must be upgraded
to version 7.0 for proper Outbound Option operation. If it is necessary to support the Outbound
Option on a Version 3.3 CallManager, the 7.0 dialer must be on a separate server, since a release
5.0(0) or 6.0(0) CallManager PG is required to support CM 3.3.

Note: After upgrading an ICM 5.0 pre-SR4 system with Outbound Option to ICM/IPCC 7.0(0),
the Outbound Option Dialer is unable to get its configuration file from the tftp server. This
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occurs because in ICM 7.0, the Outbound Option Dialer uses the instance number to build the
MAC address of the Outbound Option Dialer phones. Previously in ICM 5.0, this part of the
MAC address was always defined as 00, no matter what the instance number was. To allow the
Outbound Option Dialer to correctly get its configuration files, edit the MAC addresses of the
phones on the CallManager. These strings are built like DA + NN + DDDD + PPP where NN
= instance number, DDDD = Database ID of Dialer, and PPP = port number.

Outbound Option Dialer Technology Refresh Upgrade

Step 1 Set up the new server as outlined in Setting Up the Hardware (page 35).

Step 2 Using the ICM Service Control, stop all ICM services on the production dialer being replaced.

Step 3 Export the ICM registry from production dialer, and import the registry to the new dialer.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 4 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new dialer. Apply the automated
hardening when prompted.

Step 5 From ICM setup, edit all instances on the server and insert the new domain name.

Step 6 From ICM setup, edit all ICM components on the server and make the necessary changes based
on the environment in which the new dialer is to run.

Step 7 Exit and then rerun setup. When the main setup screen appears, select Upgrade All.

Step 8 Using ICM Service Control, set the ICM processes on the new dialer to Manual Start.

Step 9 Reboot the new dialer.

Step 10 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
new dialer.

Step 11 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new dialer.

Step 12 Using ICM Service Control, start the ICM processes on the new dialer.

Step 13 Using ICM Service Control, set the ICM processes on the new dialer to Automatic Start.

Outbound Option Dialer Common Ground Upgrade

Step 1 Using ICM Service Control, stop all ICM services on the dialer.

a. Using ICM Service Control, change all ICM services on the dialer to Manual Restart.

b. Using third party imaging or “ghost” software, perform a full system backup of the dialer
server so that it can be restored should a critical failure occur during the common ground
upgrade process.
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c. Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

d. Upgrade Third Party software such as virus protection software, VNC, or PCAnywhere.

e. Reboot the dialer.

f. Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions
of the Support Tools agent.

g. Using the Domain Manager, add the dialer instance to the appropriate Active Directory
Instance Organizational Unit.

h. Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main
setup screen to upgrade all ICM components on the dialer.

i. If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from
the ICM/bin directory, edit the instance and insert the new domain name on the dialer.

j. While in ICM setup, edit the dialer component and review all entries.

k. Reboot the dialer.

l. Install the latest 7.0 Services Release and any required Engineering Specials on the dialer.

m. Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the dialer.

Step 2 If there are CTI OS servers associated with the PG pair being upgraded which are on separate
servers, upgrade half of them now.

Upgrading Standalone CTI OS Servers

If there are CTI OS servers associated with the PG pair being upgraded that are on separate
servers, upgrade half of them now.

Standalone CTI OS Server Technology Refresh Upgrade

Step 1 Set up the new CTI OS server as outlined in Setting up the Hardware (page 35).

Step 2 Using the ICM Service Control, stop all CTI OS services on the CTI OS server being upgraded.

Step 3 Export the ICM registry from production CTI OS server, and import the registry to the new CTI
OS Server.

Note: Refer to Exporting and Importing the Registry (page 76) for additional information.

Step 4 Run setup on the CTI OS 7.0 CD to install the CTI OS server. Input the appropriate domain
name and other configuration elements as they apply to the new environment.
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Step 5 Using ICM Service Control, set the CTI OS processes on the new CTI OS Server to Manual
Start.

Step 6 Reboot the CTI OS Server.

Step 7 Install the latest CTI OS 7.0 services release and any required engineering specials on the new
CTI OS Server.

Step 8 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new CTI
OS Server.

Step 9 Using ICM Service Control, set the CTI OS processes on the new CTI OS Server to Automatic
Start.

Step 10 Adjust the clients of the original CTI OS Server to connect to the new CTI OS Server.

Step 11 Shut down the original CTI OS Server, bring the new CTI OS Server online, and verify proper
system operation.

Step 12 If CTI OS server is collocated on the PG, modify the CTI OS clients to connect to the new Side
A PG/CTI OS server.

Note: Call processing for the Peripheral being upgraded is affected until the next four steps are
completed.

Step 13 Using ICM Service Control, stop the ICM and CTI OS services on the Side B production PG.

Step 14 Using ICM Service Control, start all ICM and CTI OS services on the new Side A PG.

Step 15 Using ICM Service Control, set all of the ICM and CTI OS processes on the new Side A PG to
Automatic Start.

Step 16 Verify proper operation of the peripheral running on the new Side A PG (call flows, CTI desktops
and other applications, Outbound Option dialer).

Step 17 Repeat steps 2 through 16 to upgrade the Side B PG.

Step 18 Upgrade any remaining associated CTI OS servers on separate servers.

Standalone CTI OS Server Common Ground Upgrade

Step 1 Using ICM Service Control, stop all CTI OS services on the server being upgraded.

Step 2 Using ICM Service Control, change all CTI OS services to Manual Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the CTI OS
server so that it can be restored should a critical failure occur during the Common Ground
upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.
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Step 5 Upgrade Third Party software such as virus protection software and VNC or PCAnywhere.

Step 6 Reboot the CTI OS Server.

Step 7 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 8 Using the Domain Manager, add the CTI OS Server to the appropriate Active Directory Instance
Organizational Unit.

Step 9 Run setup on the CTI OS 7.0 CD to install the CTI OS server. Input the appropriate domain
name and other configuration elements as they apply to the new environment.

Step 10 While in CTI OS setup, review all entries and update as required.

Step 11 Reboot the CTI OS Server.

Step 12 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
CTI OS Server.

Step 13 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the CTI OS
Server.

Step 14 Using ICM Service Control, change all CTI OS services to Automatic Restart.

Step 15 Bring the upgraded CTI OS server online and verify proper system operation.

Note: Call processing for the Peripheral being upgraded is affected until the next four steps are
completed.

Step 16 Using ICM Service Control, stop the ICM and CTI OS services on the Side B PG.

Step 17 Using ICM Service Control, start all ICM and CTI OS services on the Side A PG.

Step 18 Using ICM Service Control, set all of the ICM and CTI OS processes on the Side A PG to
Automatic Start.

Step 19 Verify proper operation of the peripheral running on the upgraded Side A PG (call flows, CTI
desktops and other applications, Outbound Option dialer).

Step 20 Using third party imaging or “ghost” software, perform a full system backup of the side B
Peripheral Gateway server so that it can be restored should a critical failure occur during the
common ground upgrade process.

Step 21 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Step 22 Upgrade Third Party software such as virus protection software and VNC or PC Anywhere.

Note: Perform Step 23 through Step 36 (inclusive) on the Side B PG.

Step 23 Reboot the Side B PG.
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Step 24 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 25 Using the Domain Manager, add the PG instance to the appropriate Active Directory Instance
Organizational Unit.

Step 26 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the Side B PG.

Step 27 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the Side B PG.

Step 28 While in ICM setup, edit the PG component and review all entries.

Step 29 If CTI OS is collocated on the same server as the PG, run setup.exe from the CTI OS 7.0 CD
to install 7.0 CTI OS on side B. It is not necessary to uninstall previous versions of CTI OS.

Step 30 If this is a CM PG or a Generic PG with a CallManager PIM, upload the JTAPI Client from
CallManager.

How to Install the Cisco JTAPI Client on the Generic IPCC PG

The Cisco JTAPI Client is a Java Telephony Application Programming Interface implementation
that communicates with the Cisco CallManager.

After installing the Generic IPCC PG, you must install the Cisco JTAPI Client so that the PG
can communicate via JTAPI with Cisco CallManager. You install the Cisco JTAPI Client from
Cisco CallManager Administration.

To install the Cisco JTAPI Client:

a. Open a browser window on the PG machine.

b. Enter the URL for the CallManager Administration utility: http://<CallManager machine
name>/ccmadmin.

c. Enter the user name and password that you created when installing and configuring Cisco
CallManager.

Lab Value: cm_pg_user

d. Choose Application > Install Plug-ins.

e. Click the icon next to Cisco JTAPI. A File Download box opens.

f. Choose Run this program from its current location. Click OK.

g. On the Security Warning box, click Yes to install.

h. Choose Next or Continue through the remaining Setup screens. Accept the default
installation path.
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i. Click Finish.

j. Reboot the machine to ensure proper operation of JTAPI.

For additional information, refer to IPCC Installation and Configuration Guide for Cisco
IPCC Enterprise Edition, Cisco IPCC Enterprise Edition Release 7.0(0)  (http://
www.cisco.com/univercd/cc/td/doc/product/icm/ipccente/ipcc70d/ipcccor7/index.htm)

Step 31 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
Side B PG.

Step 32 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the Side B
PG.

Step 33 Upgrade any remaining associated CTI OS servers on separate servers.
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Network Gateway Upgrade Procedures

Gateway Technology Refresh Upgrade

How to perform a TR upgrade on an AT&T or a SS7-ITU Gateway

Note: DOS NICs are not supported by ICM/IPCC Release 7.0(0).

Step 1 Set up the new server as outlined in Setting Up the Hardware (page 35).

Step 2 Using the ICM Service Control, stop all ICM services on the production gateway being replaced.

Step 3 Install the PCI card in the new server.

Step 4 Import the Cisco systems inc. reg key from the existing Gateway to the to the new 7.0(0) systems.

Step 5 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD on the new gateway, using edit to make
necessary changes to hostnames, IPs etc.

Step 6 Check the PCI card button.

Step 7 Apply the automated hardening when prompted.

Step 8 From ICM setup, edit all instances on the server and insert the new domain name.

Step 9 From ICM setup, edit all ICM components on the server and make the necessary changes based
on the environment in which the new gateway is to run.

Step 10 Exit setup, then rerun setup from the media (do not reboot). When the main setup screen appears,
select Upgrade All.

Step 11 Reboot the server.
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Step 12 Allow the system to find the "Fatboy" PCI card. When Windows asks, the PCI drivers are
located at: ICM Installation disk \Drivers\w2k\PCI\SS7PCIDrivers.sys.

Step 13 Reboot when asked.

Step 14 Using ICM Service Control, set the ICM processes on the new gateway to Manual Start.

Step 15 Reboot the new gateway.

Step 16 Install the latest ICM/IPCC 7.0(0) service release and any required engineering specials on the
new gateway.

Step 17 Note: If the same links are being used, no changes need to be made to the SS7 configuration.
If new or different links are being used, the SS7.cfg application must be run to make the necessary
changes.

Step 18 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the new
gateway.

Step 19 Using ICM Service Control, start the ICM processes on the new gateway.

Step 20 Using ICM Service Control, set the ICM processes on the new gateway to Automatic Start.

Gateway Common Ground Upgrade

How to perform a TR upgrade on an AT&T or a SS7-ITU Gateway

Note: DOS NICs are not supported by ICM/IPCC 7.0(0).

Step 1 Using ICM Service Control, stop all ICM services on the gateway.

Step 2 Using ICM Service Control, change all ICM services on the gateway to Manual Restart.

Step 3 Using third party imaging or “ghost” software, perform a full system backup of the gateway
server so that it can be restored should a critical failure occur during the Common Ground
upgrade process.

Step 4 Uninstall the Cisco Security Agent 4.0 Agent and the ICM Policy.

Step 5 Upgrade Third Party software such as virus protection software, VNC, or PCAnywhere.

Step 6 Reboot the gateway.

Step 7 Install the Version 2.0 Support Tools agent. It is not necessary to uninstall older versions of the
Support Tools agent.

Step 8 Using the Domain Manager, add the dialer instance to the appropriate Active Directory Instance
Organizational Unit.
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Step 9 Run ICM setup.exe from the ICM/IPCC 7.0(0) CD and select Upgrade All on the main setup
screen to upgrade all ICM components on the dialer.

Step 10 If the Active Directory domain is changing as part of the upgrade, run ICM setup.exe from the
ICM/bin directory, edit the instance and insert the new domain name on the gateway.

Step 11 While in ICM setup, edit the Gateway component and review all entries.

Step 12 Reboot the gateway.

Step 13 Install the latest ICM/IPCC 7.0(0) services release and any required engineering specials on the
gateway.

Step 14 Install Cisco Security Agent 4.5 with the latest compatible CSA Agent Policy on the gateway.
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Upgrading a Localized ICM/IPCC System

Localization Upgrade Considerations

Note: Changing the Windows operating system, SQL Server, or ICM/IPCC software from one
language to another is not supported during the upgrade process.

Upgrading from ICM/IPCC 5.0(0)

There is no localized component in ICM/IPCC 5.0(0). Running Upgrade All from the FCS
version of ICM/IPCC 5.0(0) results in upgrading all English or UK components to ICM/IPCC
7.0(0).

If you have installed the localized version of Script Editor or WebView from an ICM/IPCC
5.0(0) service release, you must change the language from the AW setup before performing the
ICM/IPCC 7.0(0) upgrade process. This is because ICM Setup uses registry key
HKEY_LOCALE_MACHINE\Cisco Systems Inc.\ICM\SystemSettings\Language to install
the localized components, but, does not upgrade this registry key. In ICM/IPCC 5.0(0), the
value of the Language key is either American English or UK English.

For example, if the customer installed the Japanese version of ICM/IPCC 5.0(0) Service Release
9, the following procedure must be performed before the ICM/IPCC 7.0(0) upgrade.

From the ICM 7.0 Setup program:

Step 1 Select AW from Instance Components list.

Step 2 Click Edit.

Step 3 In the Admin Workstation Properties dialog box, select Japanese.

Step 4 Perform AW setup.
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Step 5 Exit ICM Setup.

Follow the normal ICM/IPCC 7.0(0) upgrade process to upgrade from an ICM/IPCC 5.0(0)
system.

Upgrade from ICM/IPCC 6.0(0)

The following languages list have been provided in ICM 6.0:

• English (American)

• English (United Kingdom)

• French

• German

• Japanese

• Korean

• Simplified Chinese

• Spanish

If you have installed ICM/IPCC 6.0(0) and its service release with the above languages, follow
the regular ICM/IPCC 6.0(0) to ICM/IPCC 7.0(0) upgrade process to upgrade your systems.

If you have installed the French Canadian release, follow this procedure to change the language
setting in the AW setup before performing the upgrade process.

From the ICM/IPCC 7.0(0) Setup program:

Step 1 Select AW from Instance Components list.

Step 2 Click Edit.

Step 3 At the Admin Workstation Properties dialog box, select the French (Canadian) language.

Step 4 Perform AW setup.

Step 5 Exit ICM Setup.
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CIS Upgrade Procedures
There are no new releases of the Cisco CIS components (Cisco Email Manager, Cisco
Collaboration Server, Cisco Media Blender, and Dynamic Content Adapter) in the 7.0(0) release
cycle.
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CTI OS Agent and Supervisor Desktop Upgrade
Procedures

CTI OS Agent and Supervisor Desktop Technology Refresh Upgrade

Technology Refresh upgrades are no different than fresh installations, except that the original
desktop is taken off-line. Refer to the CTI OS System Manager's Guide for Cisco ICM/IPCC
Enterprise & Hosted Editions  (http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/
icm70doc/ctidoc7/ctios7d/index.htm).

Note: Customized desktops may have different upgrade procedures which are beyond the scope
of this document.

CTI OS Agent and Supervisor Desktop Common Ground Upgrade

Upgrading the standard CTI OS Agent and Supervisor Desktops without upgrading the hardware
(CG upgrade) involves the following:

Step 1 Stop the CTI OS Agent or Supervisor Desktop application that is running on the machine.

Step 2 Run the CTI OS Client install from the ICM/IPCC 7.0(0) CD, updating configuration data as
prompted.

Step 3 Reboot the machine if directed to.
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Cisco Agent Desktop (CAD) Upgrade Procedures
The ICM PG Releases for CAD table (following) shows the upgrades that are supported for
CAD version 7.0. It also defines how the upgrade to CAD 7.0 running on a 7.0(0) PG occurs
for each version of CAD.

Note: You can not upgrade the CAD services to 7.0 on the PG and leave admin and the desktops
at a previous version. All CAD components must be at the same version. Unlike previous
versions of CAD, CAD 7.0 is a CTI OS client, and requires CTI OS V7.0 to operate.

Table 8: ICM PG Releases for CAD

ICM 7.0(0)ICM 6.0(0)ICM 5.0(0)CAD Version

Multiple stepsMultiple stepsMultiple steps4.4

Single stepSingle stepSingle step4.6

Single stepSingle step6.0

Over the top7.0

Three types of upgrades are supported:

• Single step

– An automated upgrade process by which the CAD configuration is backed up by the system
administrator on the pre-ICM/IPCC 7.0(0) system that CAD is currently running on.

– The new CAD software is installed on an ICM/IPCC 7.0(0)

– The CAD configuration is restored by the system administrator on the ICM/IPCC 7.0(0).

• Multiple steps

– A multi-step upgrade process where the existing CAD configuration is backed up on the
existing system, restored on a newer version following the CAD software install, backed
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up on the newer version, and restored on the final version following the CAD software
install.

• Over the top install

– An installation from one build of the CAD software to the next (for example, build x to
build x+1) has no backup and restore of the configuration. The software configuration is
set to a new install.

Note: For a single step or a multiple step upgrade, an intermediate configuration point exists
when the new CAD software is installed. The intermediate configuration is the “default” system
configuration. When the pre-CAD V7 system configuration is restored, the default system
configuration may be over written.

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

122

Chapter 16: - Cisco Agent Desktop (CAD) Upgrade Procedures



Remote Monitoring System (RMS) Upgrade
Procedures

Upgrading Listener Clients that Dial in via Modem

The following steps must be performed if the system supports clients dialing in via modem to
talk to the Listener application:

Step 1 Configure Microsoft RAS on the current Listener server (version 2.0 or 2.0 SR1) for TCP/IP
and NetBEUI. This enables the new ICM 7.0 Loggers to dial in. In addition, this is a needed
preparation before reconfiguring earlier ICM Logger versions to TCP

Step 2 Install new message files on the AlarmTracker Client machines by running SDDSN setup from
the latest ICM setup CD.

Step 3 Configure all Loggers to phone home using TCP. This must be done before upgrading the
Listener server to Windows 2003. This should be done over time to allow a window where
Loggers still use NetBEUI to dial in.

Upgrading RMS Components to Version 2.1

The procedure to upgrade the RMS components to version 2.1 is as follows:

Step 1 Disconnect all AlarmTracker clients and exit the application.

Step 2 Stop the Listener Service on the Listener system.

Step 3 Disable CSA and stop the CSA service on the servers being upgraded.

Step 4 Stop the LGMapper and LGArchiver services on the Mapper server.
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Step 5 Run Listener Setup on the Listener system.

Step 6 Run LGMapper Setup on the Mapper system.

Step 7 Run AlarmTracker Client Setup on the Client systems.

Step 8 Start the Listener service on the Listener systems.

Step 9 Start the LGMapper service on the Mapper servers.

Step 10 Start the LGArchiver service on the Mapper servers.

Step 11 Start the clients and connect them to the Mapper servers.

Step 12 Restart the CSA service and enable CSA on the upgraded servers.

Windows 2003 Upgrade on Listener and Mapper Servers

RMS should be upgraded to version 2.1 before upgrading the OS to Windows 2003. If using
dial-up (RAS), all Loggers must already be configured for TCP over RAS.

Prior to beginning to upgrade the operating system:

Step 1 Disconnect all AlarmTracker clients and exit the application.

Step 2 Stop the Listener Service on the Listener system.

Step 3 Disable CSA and stop the CSA service on the servers being upgraded.

Once the operating system on the Listener and Mapper servers have been upgraded:

Step 4 Start the Listener service on the Listener systems.

Step 5 Start the LGMapper service on the Mapper servers.

Step 6 Start the LGArchiver service on the Mapper servers.

Step 7 Start the clients and connect them to the Mapper servers.

Step 8 Restart the CSA service and enable CSA on the upgraded servers.
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Enhanced Database Migration Tool for ICM/IPCC
7.0

Introduction

The ICM/IPCC 5.0(0) and 6.0(0) Logger and HDS database schemas are migrated to the
ICM/IPCC 7.0(0) database schema using the Enhanced Database Migration Tool (EDMT)
during the upgrade process.

The Cisco ICM/IPCC Enhanced Database Migration Tool (EDMT) is a wizard application used
to migrate the ICM/IPCC database during the ICM/IPCC upgrade process. It can be installed
on the destination server (see Installing EDMT for additional information). The time required
to complete a data migration varies in a direct relationship to the database size (the larger the
database size, the longer it takes to migrate) and the server hardware performance level.

The EDMT requires prerequisites be completed (see the EDMT Installation Prerequisites (page
125) for additional information) prior to running the application (see Running the EDMT (page
126) for additional information).

This product includes software developed by:

• CDS Networks, Inc.

• the JDOM Project (http://www.jdom.org/)

EDMT Installation Prerequisites

Prior to installing the Enhanced Database Migration Tool (EDMT), prerequisite tasks must be
performed.
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Step 1 Create a backup copy of the source ICM/IPCC 5.0 or ICM/IPCC 6.0 MS SQL Server database.

TCP/IP protocol support must be enabled in SQL Server 2000 before the database can be
migrated to a new ICM/IPCC 7.0 server.

Step 2 Enable TCP/IP protocol support in MS SQL on the source database server and note the Port
Number (defaults to 1433 if you do not designate another).

a. Select Start > Programs > Microsoft SQL Server > SQL Server Network Utility.

b. Select the General tab.

c. Select the Instance (from the pull-down menu) on the server you want to enable TCP/IP
on.

d. In the Disabled Protocols dialog box, select TCP/IP.

e. Select Enable. TCP/IP moves to the Enabled Protocols By Order dialog box.

f. Select Named Pipes, then using the Up Arrow, ensure the order is Named Pipes first,
then TCP/IP.

g. Click OK.

EDMT Installation

Step 1 Download the Cisco ICM/IPCC Enhanced Database Migration Tool  (http://www.cisco.com/
kobayashi/sw-center/telephony/icm/icm-planner.shtml ) .

Step 2 Select where you want to run the EDMT wizard from (it can be installed on the destination
server or from the download).

Step 3 If Auto run is enabled, allow it to start the EDMT wizard.

Step 4 If Autorun is disabled, either:

• Navigate to the download and run edmt.bat to start the wizard (see Running the EDMT (page
126)).

Running the EDMT

Once you have installed the Enhanced Database Migration Tool (EDMT), run the wizard to
migrate the database. The following provides an overview of the steps to run the EDMT. For
additional information, refer to the appropriate panel discussion.

Step 1 Run edmt.bat, from the chosen location (see EDMT Installation (page 126)). The EDMT wizard
appears. Click Next.
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Step 2 Complete the EDMT wizard as per the appropriate migration sequence:

• Common Ground Migration Sequence (page 139)

-or-

• Technology Refresh Migration Sequence (page 129)

Note:

• The Migration Type selected here affects the sequence of the EDMT wizard panels displayed
as you progress through the rest of the migration process.

• The EDMT shrinks the temp database back to the original size upon completion of the data
migration.

Verifying System Conditions Using EDMT

Verifying System Conditions for a TR Upgrade

Run EDMT on the new hardware in advance of the actual upgrade to verify the following
conditions:

• Connections to the source and destination databases are available

• The collation value for the source and destination databases is:

– Latin1_General_BIN (for western/European languages -English, French, Spanish, German,
etc.)

– Japanese_BIN (for Japanese)

– Chinese_PRC_BIN (for Chinese)

– Korean_Wansung_BIN (for Korean)

– The source and destination databases are using the same collation value.

• The operating system is Windows 2003

• SQL Server 2000 is installed

• The ICM schema for the source is correct

– 77 for ICM/IPCC Release 5.0(0)

– 84 for ICM/IPCC Release 6.0(0)
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Once these checks are made, an "Are You Sure" dialog box is presented. If running EDMT just
to perform these checks, cancel out at this point.

Verifying System Conditions for a CG Upgrade

Run EDMT on the system in advance of the actual upgrade to verify the following conditions:

• Connections to the source and destination databases are available

• The collation value for the source and destination databases is:

– Latin1_General_BIN (for western/European languages -English, French, Spanish, German,
etc.)

– Japanese_BIN (for Japanese)

– Chinese_PRC_BIN (for Chinese)

– Korean_Wansung_BIN (for Korean)

– The source and destination databases are using the same collation value.

• The operating system is Windows 2000

• SQL Server 2000 is installed

• The ICM schema for the source is correct

– 77 for ICM/IPCC Release 5.0(0)

– 84 for ICM/IPCC Release 6.0(0)

Once these checks are made, an "Are You Sure" dialog box is presented. If running EDMT just
to perform these checks, cancel out at this point.

The following procedure describes the steps necessary to perform a Common Ground upgrade
on an ICM/IPCC system if the system being upgraded has a single HDS/WebView Server, and
it is necessary for reporting to be available at all times during the upgrade process. This procedure
requires that a temporary HDS be configured to provide reporting after the upgraded CallRouter
and Logger are on-line, but before the Distributor AW/HDS upgrade is complete.

Before undertaking a Common Ground upgrade, it's important that the newly deployed servers
be installed. The Active Directory environment (whether corporate or dedicated to the ICM/IPCC
applications) must be configured/staged. The Windows Firewall configuration scripts must be
deployed before ICM/IPCC servers can accept network connections. Refer to the guidelines
outlined in the Staging Guide for Cisco ICM/IP Call Center Enterprise and Hosted Editions
Software, Release 7.0(0) for further information.

Note: Cisco Security Agent must not be installed on the new servers until the appropriate step
in the upgrade process. ICM setup checks for older versions of Cisco Security Agent and provides
warnings or prevents continuation if an older version of CSA is installed or running.
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EDMT Wizard Menus and Common Field(s)/Button(s)

File Menu

DescriptionOption

Selecting this menu option exits the EDMT application. It provides the same functionality as clicking
the Windows "Close" button (X) or selecting Alt-F4.

Exit

If the database migration is running, a warning appears informing you that you are interrupting the
migration.

• Click Yes to terminate the data migration and exit.

• Click No (the default) to allow the migration to continue.

Help Menu

DescriptionOption

Selecting this menu option activates the Enhanced Database Migration Tool
(EDMT) Help file in a new window.

Help

Selecting this menu option displays information about the application including
the title, release, and copyright information.

About Cisco ICM/IPCC Enhanced
Database Migration Tool

Common Field(s)/Button(s)

Each EDMT panel contains one or more of the following common field(s) and/or button(s).

DescriptionField/Button

Provides information about the displayed panel.Description field

Click to return to the previous panel.Back

Click to advance to the next panel.Next

Note: Once you click Next on the Migration Version/Type panel, the title of the application
changes to add the type of migration. Thus, the title becomes either "Cisco ICM/IPCC
Enhanced Database Migration Tool: Common Ground" or "Cisco ICM/IPCC Enhanced
Database Migration Tool: Technology Refresh".

Technology Refresh Migration Sequence

In the case of a Technology Refresh upgrade, EDMT must be installed and configured on the
new Cisco ICM/IPCC Enterprise and Hosted Edition Hardware and System Software
Specification (Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
products_user_guide_list.html) compliant destination database server machine. Once installed

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

129

Chapter 18: Enhanced Database Migration Tool for ICM/IPCC 7.0

EDMT Wizard Menus and Common Field(s)/Button(s)

http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1001/products_user_guide_list.html


and configured, running EDMT automatically performs a backup of the ICM/IPCC source
database onto the new destination server.

Note:

• Prior to running EDMT set the Maximum file size for the data files on the source database to
Unrestricted growth. Refer to How to set the Logger or HDS database data file size for
maximum growth (page 146) for additional information.

• If the reporting capabilities on a system with a single HDS must be maintained throughout
the upgrade, it is necessary to create a temporary HDS database.

Next, EDMT restores the backup to the destination database and performs what amounts to a
Common Ground migration on the newly restored ICM/IPCC 5.0 or ICM/IPCC 6.0 database.
The backup file created is automatically deleted. This migration is complete upon successful
execution of the EDMT.

The Technology Refresh migration EDMT panel sequence is:

1. Migration Version and Migration Type panels

2. Source Database Connection and Destination Database Connection Panels

3. Backup Connection and Destination Restore Device Location panels

4. Migration Control panel

Migration Version and Migration Type Panels

This panel allows you to select the ICM/IPCC release you are migrating from/to (upgrading an
ICM/IPCC 5.0 database to ICM/IPCC 7.0, or upgrading an ICM/IPCC 6.0 database to ICM/IPCC
7.0) and the migration process to be used (Common Ground or Technology Refresh).

Figure 7: Migration Version and Migration Type Panels

How to select the Migration Version

Step 1 Click the appropriate button:

• ICM/IPCC 5.0 to ICM/IPCC 7.0

-or-

• ICM/IPCC 6.0 to ICM/IPCC 7.0

Step 2 Continue to the next section of the panel and select the Migration Type.
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How to select the Migration Type

Step 1 Click the appropriate button:

• Common Ground

-or-

• Technology Refresh

In this case, select Technology Refresh.

In the case of a Technology Refresh upgrade, EDMT must be installed and run on the new Cisco
ICM/IPCC Enterprise and Hosted Edition Hardware and System Software Specification
(Bill of Materials)  (http://www.cisco.com/en/US/products/sw/custcosw/ps1001/
products_user_guide_list.html) compliant destination database server machine. Once installed,
running EDMT automatically performs a backup of the ICM/IPCC source database onto the
new destination server. Next, EDMT restores the backup to the destination database and performs
what amounts to a Common Ground migration on the newly restored ICM/IPCC 5.0 or ICM/IPCC
6.0 database. The backup file created is automatically deleted.

This migration is complete upon successful execution of the EDMT.

Step 2 Click Next to continue.

Note: Once you click Next on the Migration Version/Type panel, the title of the application
changes to add the type of migration. Thus, the title becomes either "Cisco ICM/IPCC Enhanced
Database Migration Tool: Common Ground" or "Cisco ICM/IPCC Enhanced Database Migration
Tool: Technology Refresh".

Source Database Connection and Destination Database Connection Panels

Enter the information required to connect to the migration source database server.

This panel requires you to enter the information necessary for the EDMT to connect to the
migration source and migration destination database servers during a Technology Refresh
migration.

Figure 8: Source and Destination Database Connection Panels

Table 9: Source Database Connection Panel Properties

DescriptionField/Button

Enter the host name, or IP address, of the source server hosting the database (Logger
or HDS).

Host Name/IP Address

Enter the name of the ICM/IPCC 5.0(0) or ICM/IPCC 6.0(0) source database.ICM Database Name
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DescriptionField/Button

Enter the TCP/IP port in which the source SQL Server is running. This field defaults
to 1433, the standard SQL Server port, if you do not designate another port.

SQL Server Port Number

Enter the domain name of the Windows account specified in the Windows Username
field.

Windows Domain Name

Enter the Windows account user name in which to access the source database server.Windows Username

Note: This user requires permissions to the master database, as well as to the ICM
database. This user must also have the permissions necessary to perform a database
backup/restore. An account with SQL Server sysadmin privileges is sufficient.

Enter the password for the user name entered in the Windows Username field.Windows Password

Table 10: Destination Database Connection Panel Properties

DescriptionField/Button

Enter the host name, or IP address, of the destination server hosting the database
(Logger or HDS).

Host Name/IP Address

Disabled. This field automatically displays the database name of the ICM 5.0(0) or
ICM 6.0(0) source server entered on the previous screen. ICM requires the database
names to be the same.

ICM Database Name

Enter the TCP/IP port in which the destination SQL Server is running. This field
defaults to 1433, the standard SQL Server port, if you do not designate another port.

SQL Server Port Number

Enter the domain name of the Windows account specified in the Windows Username
field.

Windows Domain Name

Enter the Windows account user name in which to access the destination database
server.

Windows Username

Note: This user requires permissions to the master database, as well as to the ICM
database. This user must also have the permissions necessary to perform a database
backup/restore. An account with SQL Server sysadmin privileges is sufficient.

Enter the password for the user name entered in the Windows Username field.Windows Password

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

132

Chapter 18: - Enhanced Database Migration Tool for ICM/IPCC 7.0

Technology Refresh Migration Sequence



How to enter the information required to connect to the migration source database server

Step 1 Click the appropriate field and enter the following migration source database server information:

• Host Name/IP Address

• ICM Database Name

• SQL Server Port Number

• Windows Domain Name

• Windows Username

• Windows Password

Step 2 Continue to the Migration Destination Database Connection panel.

How to enter the information required to connect to the migration destination database server

Step 1 Click the appropriate field and enter the following migration destination database server
information:

• Host Name/IP Address

• ICM Database Name

• SQL Server Port Number

• Windows Domain Name

• Windows Username

• Windows Password

Step 2 Click Next to continue to the Backup Connection and Restore Location panels.

Note: While you enter the required data on this panel, clicking Next does not make the actual
connection. At this point the data entered is only checked for completeness prior to allowing
you to continue. The connection does not take place until after you start the data migration by
clicking Start Migration on the Migration Control panel.

Backup Connection and Restore Location Panels

The Backup Connection panel requires you to enter the information necessary for EDMT to
backup the migration source database during a Technology Refresh migration.
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The Restore Location panel allows you to specify the following for the migration source database
backup that is restored for use during the upgrade:

• Enter the folder location (path) for the data files for the ICM/IPCC 7.0(0) database during a
Technology Refresh migration on the destination server.

• Enter the folder location (path) for the transaction log files of the ICM/IPCC 7.0(0) database
created during a Technology Refresh migration on the destination server.

Note: These paths must exist on the destination server or EDMT displays a dialog with an error.

In order for EDMT backup/restore with mapped drives to work properly, the SQL Server service
(MSSQLSERVER) on the source machine needs to be set to "Log On" as an ICM domain/AD
user with appropriate permissions instead of using the "LocalSystem" account. That same ICM
domain/AD user needs to be a local administrator on the source machine and also needs read/write
permissions to the backup share.

If you are backing up to a third box instead of the destination machine, then the destination
machine needs to be setup in a similar fashion, for example: SQL Server service Log On as a
domain user, the domain user is a local administrator, and has read/write permissions to the
backup share.

Figure 9: Backup and Restore Location Panels

Table 11: Backup Connection Panel Properties

DescriptionField/Button

Enter the host name, or IP address, of the server hosting the Windows share. In
most cases, this is the host name or IP address of the destination database server.

Host Name/IP Address

This defaults to the value you entered for the destination database server, but it may
be changed.

Enter the name of the Windows share that is the location for the backup database
file.

Windows Share Name

Note: This could be a Windows administrative share (such as C$) or a different
shared folder name.

Enter the domain name of the Windows account specified in the Windows Username
field.

Windows Share Domain

Enter a Windows user name that has read/write permissions to the specified
Windows share.

Windows Share Username

Enter the password for the user name entered in the Windows Share Username
field.

Windows Share Password
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How to enter the information required for EDMT to backup the migration source database

Step 1 Host Name/IP Address•

• Windows Share Name

• Windows Share Domain

• Windows Share Username

• Windows Share Password

Step 2 Continue to the Restore Location panel.

How to enter the restore location for the data file and the log file

Step 1 Click the appropriate field and enter the following information:

• Data File Location

• Log File Location

Note: You can also Browse to the desired location for the data file or the log file.

Step 2 Click Next to continue to the Migration Control panel.

Migration Control Panel

This EDMT panel allows you to start or terminate the data migration. It also displays the status
of the data migration process.

Figure 10: Migration Control Panel

DescriptionField/Button

Indicates the completion status of the migration progress after Start Migration is clicked. As each task
of the database migration completes, the Migration Progress moves one bar. Some tasks take longer
than others and this is reflected in the movement of the progress bar.

Migration
Progress

Note: If an error occurs during the migration process, the Migration Progress bar changes from its
standard color to red.

When Start Migration is clicked, a warning appears stating:Status
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DescriptionField/Button

Data and schema corruption may result if this process is interrupted. The ICM/IPCC database would
then be in an inconsistent state and need to be restored from backup. Are you sure you want to start the
data migration?

Click No to terminate the migrations.

Click Yes to start the data migration.

This field then displays each task of the migration process as it starts and finishes. It also indicates when
the migration process started, ended, and how long it took.

Each message in the Status field is logged. Errors shown in this field are presented in bold italic red
text. The EDMT logs directory is located in the TEMP directory on the Windows system drive (typically
C:\TEMP).

This button tests the entered database connection values by attempting to access the database(s). All of
the connection information was checked for validity when entered on its respective panels. The

Start
Migration

connections check reports whether the database connections were made or not in the migration Status
field.

A successful source database connection result is indicated by the following Status messages:

Status:

• Checking the connection to the database dd1_sideA on <source hostname>:<source port> ...

• Verifying the SQL Server collation on the source ddelo-w2ksvr ...

• Source SQL Server collation (Latin1_General_BIN) OK

• Verifying the operating system version on the source ddelo-w2ksvr ...

• Source operating system version (Windows 2003) OK

• Verifying the SQL Server version on the source ddelo-w2ksvr ...

• Source SQL Server version (SQL Server 2000) OK

• Verifying ICM/IPCC Schema version on the source ddelo-w2ksvr ...

• Source ICM/IPCC Schema version (ICM/IPCC 5.0) OK

• Database connection to the source verified OK

A successful destination database connection result is indicated by the following Status messages:
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DescriptionField/Button

Status:

• Checking the connection to the database dd1_sideA on the destination <destination server> ...

• Verifying the SQL Server collation on the <destination server> ...

• Destination SQL Server collation (Latin1_General_BIN) OK

• Verifying the operating system version on the destination <destination server> ...

• Destination operating system version (Windows 2000) OK

• Verifying the SQL Server version on the destination <destination server> ..

• Destination SQL Server version (SQL Server 2000) OK

• Database connection to the destination verified OK

• Verifying the source SQL Server and destination SQL Server using the same collation ...

• Both source and destination SQL Servers using the same collation (Latin1_General_BIN)

If a problem occurs, go back to the appropriate panel and change the incorrect information. If the
connections check passed, the database migration process starts.

Disabled until the migration process starts.Terminate
Migration and
Exit When clicked, the following a warning appears:

"Data and schema corruption may result if this process is interrupted. The ICM/IPCC database would
then be in an inconsistent state. The backup/restore process would then need to be performed again.
Are you sure you want to terminate the data migration?"

If you select Yes, the migration terminates and the tool exits.

If you terminate the migration, you must then perform the following:

1. Drop the database restored on the destination server.

2. Rerun EDMT.

If you select No, the migration continues.

How to start the data migration process

Step 1 Click Start Migration.

The following warning appears:
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"Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state. The backup/restore process would then need to be
performed again. Are you sure you want to start the data migration?

Click No to abort the data migration.

Click Yes to start the data migration."

This field then displays each task of the migration process as it starts and finishes. It also indicates
when the migration process started, ended, and how long it took.

Each message in the Status field is logged. Errors shown in this field are presented in bold italic
red text. The EDMT logs directory is located in the TEMP directory on the Windows system
drive (typically C:\TEMP).

Step 2 Select the appropriate choice.

How to terminate the in-progress data migration

If it becomes necessary to terminate an in-progress data migration, perform the following.

Step 1 Click Terminate Migration and Exit.

The following warning appears:

"Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state and need to be restored from backup. Are you sure you
want to terminate the data migration?

Click Yes to terminate the migration process and exit the application.

Click No to continue the migration process."

Step 2 Select the appropriate choice.

If you terminate the migration, you must then perform the following:

• Drop the database restored on the destination server.

• Rerun EDMT.
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Common Ground Migration Sequence

Overview

In the case of a Common Ground upgrade, the Logger or HDS database is being migrated in
place and the existing database schema is modified from either ICM/IPCC 5.0 or ICM/IPCC
6.0 to the level of ICM/IPCC 7.0. For this to occur, EDMT must be installed and configured
on the database server being migrated.

Note: Prior to running EDMT set the Maximum file size for the data files on the database to
Unrestricted growth. Refer to How to set the tempdb database size (page 148) for additional
information.

This migration is complete upon successful execution of the EDMT.

The Common Ground migration EDMT panel sequence is:

1. Migration Version and Migration Type panels

2. Database Connection panel

3. Migration Control panel

Migration Version and Migration Type Panels

This panel allows you to select the ICM/IPCC release you are migrating from/to (upgrading an
ICM/IPCC 5.0 database to ICM/IPCC 7.0, or upgrading an ICM/IPCC 6.0 database to ICM/IPCC
7.0) and the migration process to be used (Common Ground or Technology Refresh).

Figure 11: Migration Version and Migration Type Panels

How to select the Migration Version

Step 1 Click the appropriate button:

• ICM/IPCC 5.0 to ICM/IPCC 7.0

-or-

• ICM/IPCC 6.0 to ICM/IPCC 7.0

Step 2 Continue to the next section of the panel and select the Migration Type.
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A Common Ground migration means the Logger or HDS database is being migrated in place
and the existing database schema modified from either ICM/IPCC 5.0 or ICM/IPCC 6.0 to the
level of ICM/IPCC 7.0. For this to occur, EDMT must be installed and run on the database
server being migrated. This migration is complete upon successful execution of the EDMT.

How to select the Migration Type

Step 1 Click the appropriate button:

• Common Ground

-or-

• Technology Refresh

In this case, select Common Ground.

A Common Ground migration means the Logger or HDS database is being migrated in place
and the existing database schema modified from either ICM/IPCC 5.0 or ICM/IPCC 6.0 to the
level of ICM/IPCC 7.0. For this to occur, EDMT must be installed and run on the database
server being migrated. This migration is complete upon successful execution of the EDMT.

Step 2 Click Next to continue.

Note: Once you click Next on the Migration Version/Type panel, the title of the application
changes to add the type of migration. Thus, the title becomes either "Cisco ICM/IPCC Enhanced
Database Migration Tool: Common Ground" or "Cisco ICM/IPCC Enhanced Database Migration
Tool: Technology Refresh".

Database Connection Panel

On this panel you enter the information necessary to enable the EDMT to connect to the source
database server during a Common Ground migration.

Figure 12: Database Connection Panel

Table 12: Database Connection Panel Properties

DescriptionField/Button

Enter the host name, or IP address, of the server hosting the database (Logger or
HDS).

Host Name/IP Address

Enter the name of the ICM/IPCC 5.0(0) or ICM/IPCC 6.0(0) source database.ICM Database Name

Enter the TCP/IP port in which the source SQL Server is running. This field defaults
to 1433, the standard SQL Server port.

SQL Server Port Number
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DescriptionField/Button

Enter the domain name of the Windows account specified in the Windows Username
field.

Windows Domain Name

Enter the Windows account user name in which to access the database server.Windows Username

Note: This user requires permissions to the master database, as well as to the ICM
database. This user must also have the permissions necessary to perform a database
backup/restore.

Enter the password for the user name entered in the Windows Username field. An
account with SQL Server sysadmin privileges is sufficient.

Windows Password

How to enter the information required to connect to the source database server

Step 1 Click the appropriate field and enter the following migration source database server information:

• Host Name/IP Address

• ICM Database Name

• SQL Server Port Number

• Windows Domain Name

• Windows Username

• Windows Password

Step 2 Click Next to continue to the Migration Control panel.

Note: While you enter the required data on this panel, clicking Next does not make the actual
connection. At this point the data entered is only checked for completeness prior to allowing
you to continue. The connection does not take place until after you start the data migration by
clicking Start Migration on the Migration Control panel.

Migration Control Panel

This EDMT panel allows you to start or terminate the data migration. It also displays the status
of the data migration process.

Figure 13: Migration Control Panel

DescriptionField/Button

Indicates the completion status of the migration progress after Start Migration is clicked. As each
task of the database migration completes, the Migration Progress moves one bar. Some tasks take
longer than others and this is reflected in the movement of the progress bar.

Migration
Progress
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DescriptionField/Button

Note: If an error occurs during the migration process, the Migration Progress bar changes from its
standard color to red.

When Start Migration is clicked, a warning appears stating:Status

Data and schema corruption may result if this process is interrupted. The ICM/IPCC database would
then be in an inconsistent state and need to be restored from backup. Are you sure you want to start
the data migration?

Click No to abort the migration.

Click Yes to start the data migration.

This field then displays each task of the migration process as it starts and finishes. It also indicates
when the migration process started, ended, and how long it took.

Each message in the Status field is logged. Errors shown in this field are presented in bold italic red
text. The EDMT logs directory is located in the TEMP directory on the Windows system drive
(typically C:\TEMP). The active log file is called “edmt2.log”.

This tests the entered database connection values by attempting to access the database(s). All of the
connection information was checked for validity when entered on its respective panels.

Start Migration

The connections check reports whether the database connections were made or not in the migration
Status field.

A successful source database connection result is indicated by the following Status messages:

Status:

• Checking the connection to the database dd1_sideA on <source hostname>:<source port> ...

• Verifying the SQL Server collation ...

• SQL Server collation (Latin1_General_BIN) OK

• Verifying the operating system version ...

• Operating System version (Windows 2000) OK

• Verifying the SQL Server version ...

• SQL Server version (SQL Server 2000) OK

• Verifying ICM/IPCC Schema version ...

• ICM/IPCC Schema version (ICM/IPCC 5.0) OK

If a problem occurs, go back to the appropriate panel and change the incorrect information.

If the connection check passed, the database migration process starts.
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DescriptionField/Button

Disabled until the migration process starts.Terminate
Migration and
Exit When clicked, the following warning appears:

"Data and schema corruption may result if this process is interrupted. The ICM/IPCC database would
then be in an inconsistent state and need to be restored from backup. Are you sure you want to terminate
the data migration?

Click Yes to terminate the migration process and exit the application.

Click No to continue the migration process."

Note: If you terminate the data migration you must restore the database from the backup using the
overwrite option.

How to start the data migration process

Step 1 Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state and need to be restored from backup. Are you sure you
want to start the data migration?

Click Yes to start the data migration.

Click No to abort the data migration.

Step 2 Select the appropriate choice.

How to terminate the in-progress data migration

Step 1 Click Terminate Migration and Exit.

The following warning appears:

Data and schema corruption may result if this process is interrupted. The ICM/IPCC database
would then be in an inconsistent state and need to be restored from backup. Are you sure you
want to terminate the data migration?

Click Yes to terminate the migration process and exit the application.

Click No to continue the migration process.

Step 2 Select the appropriate choice.

Note: If you terminate the data migration you must restore the database from the backup using
the overwrite option.
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Database Tasks
This section contains the following topics:

• How to create an ICM Database for the Technology Refresh Restore Process, page 145
• How to set the Logger or HDS database data file size for maximum growth using SQL

Enterprise Manager, page 146
• How to Determine the Size of an ICM Database, page 147
• How to Set the tempdb Database Size, page 148

How to create an ICM Database for the Technology Refresh Restore Process

Step 1 Launch Start > Programs > Microsoft SQL Server > Enterprise Manager.

Step 2 Expand Microsoft SQL Servers by clicking the + icon next to it.

Step 3 Expand SQL Server Group by clicking the + icon next to it.

Step 4 Expand server name where the destination database is to be created by clicking the + icon next
to it.

Step 5 Right-click the Databases folder and select New Database…

Step 6 Under the General tab in the Database Properties dialog box, enter the new database name.
This name must match the name, including case, on the existing source database name.

Step 7 Select the Data Files tab.

Step 8 Set file to Automatically grow file.

Step 9 Set the Initial size (MB) field to be greater than or equal to the current source ICM database.

Step 10 In the Maximum file size section, click Restrict file growth (MB) and set the value to a suitable
maximum size (see How to Determine the Size of an ICM Database (page 147), for addition
information).
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Note: The maximum size must not exceed 80% of the total disk space available on the system.

Step 11 Click the Transaction Log tab

Step 12 Set the Initial Size to 500 MB.

Step 13 Insure both Automatically grow file and Unrestricted file growth are selected.

Step 14 Click OK.

Step 15 You must now configure your database.

Step 16 Expand the Databases folder clicking on the + icon.

Step 17 Right-click the just created ICM database.

Step 18 Select Properties....

Step 19 Select the Options tab and set the following values:

• ANSI NULL default: No

• Recursive triggers: No

• Auto update statistics: Yes

• Torn page detection: Yes

• Auto close: No

• Auto shrink: No

• Auto create statistics: Yes

• Auto create statistics: Yes

• Use quoted identifier: No

• Leave all other parameters at their default values.

Step 20 If changes have been made, the MSSQLSERVER Service may need to be cycled.

Step 21 Close SQL Enterprise Manager.

How to set the Logger or HDS database data file size for maximum growth using SQL Enterprise Manager

Step 1 Launch Start > Programs > Microsoft SQL Server > Enterprise Manager.

Step 2 Expand Microsoft SQL Servers by clicking the + icon next to it.

Step 3 Expand SQL Server Group by clicking the + icon next to it.
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Step 4 Expand server name where the destination database is to be created by clicking the + icon next
to it.

Step 5 In the Databases folder, drill down and select the appropriate database.

Step 6 Right-click on the selected database and select Properties.

Step 7 Select the Data Files tab.

Step 8 Set file to Automatically grow file.

Step 9 In the Maximum file size section, click Unrestrict file growth (in MB).

How to Determine the Size of an ICM Database

When migrating from an older ICM/IPCC release to a newer ICM/IPCC release, you need to
lookup the database size of the existing ICM database. This number is used later in the process
to create an ICM database of the same size. This value may be increased depending on planned
ICM 7.0(0) usage patterns. Find the database size either by launching the ICMDBA program
or by launching the Microsoft ISQL_w program on the SQL Server.

Using ICMDBA

Step 1 Select Start > Run.

Step 2 In the Run dialog type cmd and click OK (or press Enter).

Step 3 At the command prompt type icmdba.

Step 4 Drill down to the Logger/HDS database.

Step 5 Right-click cust_sideX and select Properties to observe the database size.

Using SQL Enterprise Manager

Step 1 On a system that has Microsoft SQL Server 2000 installed, navigate to the SQL Server 2000
install directory (by default at C:\Program Files\Microsoft SQL Server\MSSQL\Install).

Step 2 On the SQL Server systems, launch Start > Programs > Microsoft SQL Server> ISQL_w.
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Step 3 Enter the required database connection information:

• Make sure that the current system name is selected.

• Select Use Standard Security.

• Make sure the login id is sa or equivalent.

• Supply a password if required.

Step 4 Click Connect.

Step 5 The Microsoft ISQL_w application opens. Make sure the selected database in the DB: drop
down is master.

Step 6 Select File > Open from the Microsoft ISQL/w menu.

Step 7 Enter EXECUTE sp_helpdb into the Query window and execute the script by clicking the green
arrow or by selecting Query > Execute from the Microsoft ISQL/w menu.

Step 8 Note the value located in the db_size column for the ICM database.

Step 9 Exit the Microsoft ISQL/w program.

How to Set the tempdb Database Size

The size and configuration of the tempdb database during data migration differs for the parameters
used in a production system. This section describes how to set tempdb for each case.

For Data Migration

Step 1 Select Start > Programs > Microsoft SQL Server > Enterprise Manager.

Step 2 Expand Databases by clicking on the + icon, right-click on the tempdb database, and select
Properties.

Step 3 Click on the Data Files tab. Set the following parameters:

• Space Allocated must be at least 1400 MB.

• Set Automatically grow files.

• Set Unrestricted file growth.
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Step 4 Click on the Transaction Log tab. Set the following parameters:

• Space Allocated must be at least 400 MB.

• Set Automatically grow files.

• Set Unrestricted file growth.

Step 5 Click OK.

Step 6 Close SQL Enterprise Manager.

For Production Systems

Step 1 Select Start > Programs > Microsoft SQL Server > Enterprise Manager.

Step 2 Expand Databases by clicking on the + icon, right-click on the tempdb database, and select
Properties.

Step 3 Click on the Data Files tab. Set the following parameters:

• Space Allocated must be at least 100 MB. The allocated space may be significantly larger
after data migration. If so, shrink the file down to 100 MB.

• Set Automatically grow files.

• Set Maximum file size to 500 MB.

Step 4 Click on the Transaction Log tab. Set the following parameters:

• Space Allocated must be at least 50 MB.

• Disable Automatically grow files.

Step 5 Click OK.

Step 6 Close SQL Enterprise Manager.
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Upgrade Checklists
Select one of the following checklists. Make your choice based on the upgrade procedure that
most fits your ICM/IPCC system upgrade requirements. Modify the checklist as necessary, to
match the upgrade requirements of your specific system.

This section contains the following topics:

• Technology Refresh Upgrade Checklists, page 151
• Common Ground Upgrade Checklists, page 159

Technology Refresh Upgrade Checklists

Select the appropriate Technology Refresh checklist for your ICM/IPCC system upgrade.

Table 13: Production HDS/Distributor AW Upgraded in Parallel with the Central Controller Upgrade Maintenance Window

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this checklist MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).
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CommentsAction/ReferenceStep/Completed

Complete the applicable baseline requirements:1. Upgrade the production system to
the required baseline.

• Ensure all ICM nodes are at ICM/IPCC Release 5.0(0)
or ICM/IPCC Release 6.0(0).__________

• Ensure all ICM/IPCC nodes are running Windows
2000 SP4.

• Ensure the Logger and HDS are running SQL Server
2000 SP4.

• Ensure the CAD is at Release 4.6 or 6.0 on Windows
2000 Server SP4 and MSDE 2000 SP3a.

• Ensure the CTI OS desktops are at Version 4.7, 5.0,
5.1, or 6.0.

• Ensure CEM, CCS, CMB at Version 5.0.

• Ensure DCA is at Version 2.1.

• Ensure CCM is at Version 3.3, 4.0, or 4. 1, with the
compatible IP IVR or CVP (ISN) version.

• Ensure all ACDs are at a version compatible with
ICM/IPCC 7.0(0).

• Ensure the hardware meets BOM specifications.

• Create and configure the Active Directory environment
for ICM/IPCC.

• Run the Windows firewall configuration scripts to
enable network connectivity.

• Ensure the ICM/IPCC Support Tools Server is
upgraded to Version 2.0.

• Perform a backup of the existing servers and verify
the backups.

For additional information refer to Baseline Requirements
(page 17).

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

152

Chapter 20: - Upgrade Checklists

Technology Refresh Upgrade Checklists



CommentsAction/ReferenceStep/Completed

AD considerations for upgrade:2. Create the Active Directory
environment.

• Migrating users from the old domain to the new domain
using the Domain Conversion Tool.__________

• Put the new servers in the Active Directory domain in
the appropriate ICM OU.

• Validate IP connectivity and remote access.

• If the AD domain controller is on the Logger, migrate
the domain controller roles to new non-ICM servers.

Note: Refer to "Migrating Active Directory and DNS
to a Non-ICM Server" for additional information.

• Bring up the new domain controllers on the domain in
which the ICM operates.

• Transfer any applicable flexible single master
operations (FSMO) roles.

• Demote the domain controller on the production
Logger to a member server.

For additional information refer to Domain Conversion
Tool and Active Directory (page 45).

Before performing a TR upgrade:3. Set up the new hardware.

• Install Windows 2003 and the latest service pack.__________

• Deploy the Windows Firewall scripts.

• Install SQL Server 2000 including the latest supported
service pack.

• Install Version 2.0 Support Tools Agent.

• Install the required Third Party software.

• Install the newly deployed servers.

• Verify system conditions using the EDMT.

For additional information see Setting Up the Hardware
(page 35).

Refer to Setting Up a Temporary ICM/IPCC 7.0(0)
AW/HDS (page 80).

4. Set up a temporary 7.0
HDS/Distributor AW.

__________
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CommentsAction/ReferenceStep/Completed

**************************************Start of Central Controller
Upgrade Maintenance Window

Refer to Distributor AW/HDS Technology Refresh
Upgrade (page 70).

5. Upgrade the Side A
HDS/Distributor AW.

__________

Refer to Logger Technology Refresh Upgrade: Side A/B
(page 85).

6. Upgrade the Side A Logger.

__________

Refer to CallRouter Technology Refresh Upgrade: Side
A/B (page 91).

7. Upgrade the Side A CallRouter.

__________

Refer to WebView Installation Guide58. Install the WebView server(s) if
not collocated on the AW/HDS.

__________

None.9. Bring down the production system
(CallRouters, Loggers, and AWs).

__________

Bring up the new Side A CallRouter
and Logger.

__________

Point the temporary HDS/Distributor
AW, PGs, and CIS components to
the new CallRouter & Logger in the
new domain.

__________

Refer to CallRouter Technology Refresh Upgrade: Side
A/B (page 91).

10. Upgrade the Side B CallRouter.

__________

Refer to Logger Technology Refresh Upgrade: Side A/B
(page 85).

11. Upgrade the Side B Logger.

__________

**************************************End of Central Controller
Upgrade Maintenance Window

Refer to Distributor AW/HDS Technology Refresh
Upgrade (page 70).

12. Upgrade the Side B
HDS/Distributor AW.

__________

5) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

154

Chapter 20: - Upgrade Checklists

Technology Refresh Upgrade Checklists

http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm


CommentsAction/ReferenceStep/Completed

None.13. Bring up the Upgraded the Side
A HDS/Distributor AW S, when
available, at any point after Step 8.

__________

None.14. Bring up the Upgraded the Side
B HDS/Distributor AW.

__________

Refer to:15. Upgrade the AWs, PGs, RMS,
and CIS components.

• Administrative Workstation (AW) Upgrade Procedures
(page 67)__________

• PG Technology Refresh Upgrade (page 100)

• Remote Monitoring System (RMS) Upgrade
Procedures (page 123)

• CIS Upgrade Procedures (page 117)

Table 14: Production HDS/Distributor AW Upgraded before the Central Controller Upgrade Maintenance Window

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this checklist MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).
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CommentsAction/ReferenceStep/Completed

Complete the applicable baseline requirements:1. Upgrade the production system
to the required baseline.

• Ensure all ICM nodes are at ICM/IPCC Release 5.0(0)
or ICM/IPCC Release 6.0(0).__________

• Ensure all ICM/IPCC nodes are running Windows 2000
SP4.

• Ensure the Logger and HDS are running SQL Server
2000 SP4.

• Ensure the CAD is at Release 4.6 or 6.0 on Windows
2000 Server SP4 and MSDE 2000 SP3a.

• Ensure the CTI OS desktops are at Version 4.7, 5.0, 5.1,
or 6.0.

• Ensure CEM, CCS, CMB at Version 5.0.

• Ensure DCA is at Version 2.1.

• Ensure CCM is at Version 3.3, 4.0, or 4. 1, with the
compatible IP IVR or CVP (ISN) version.

• Ensure all ACDs are at a version compatible with
ICM/IPCC 7.0(0).

• Ensure the hardware meets BOM specifications.

• Create and configure the Active Directory environment
for ICM/IPCC.

• Run the Windows firewall configuration scripts to enable
network connectivity.

• Ensure the ICM/IPCC Support Tools Server is upgraded
to Version 2.0.

• Perform a backup of the existing servers and verify the
backups.

For additional information refer to Baseline Requirements
(page 17).
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CommentsAction/ReferenceStep/Completed

AD considerations for upgrade:2. Create the Active Directory
environment.

• Migrating users from the old domain to the new domain
using the Domain Conversion Tool.__________

• Put the new servers in the Active Directory domain in
the appropriate ICM OU.

• Validate IP connectivity and remote access.

• If the AD domain controller is on the Logger, migrate
the domain controller roles to new non-ICM servers.

Note: Refer to "Migrating Active Directory and DNS to
a Non-ICM Server" for additional information.

• Bring up the new domain controllers on the domain in
which the ICM operates.

• Transfer any applicable flexible single master operations
(FSMO) roles.

• Demote the domain controller on the production Logger
to a member server.

For additional information refer to Domain Conversion
Tool and Active Directory (page 45).

Before performing a TR upgrade:3. Set up temporary release 5.0 or
release 6.0 HDS/Distributor AW.

• Install Windows 2003 and the latest service pack.
__________

• Deploy the Windows Firewall scripts.

• Install SQL Server 2000 including the latest supported
service pack.

• Install Version 2.0 Support Tools Agent.

• Install the required Third Party software.

• Install the newly deployed servers.

• Verify system conditions using the EDMT.

For additional information refer to Setting Up the Hardware
(page 35).

Refer to the Distributor AW/HDS Common Ground
Upgrade (page 78).

4. Upgrade the Side A
HDS/Distributor AW.

__________
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CommentsAction/ReferenceStep/Completed

Refer to the WebView Installation Guide6.5. Install the WebView server(s)
if not co-located on the AW/HDS.

__________

**************************************Start of Central Controller
Upgrade Maintenance Window

Refer to the Logger Common Ground Upgrade: Side A/B
(page 87).

6. Upgrade the Side A Logger.

__________

Refer to the CallRouter Common Ground Upgrade: Side A
(page 92).

7. Upgrade the Side A CallRouter.

__________

None.8. Bring down the side B
CallRouter, Logger, and all
distributor and client AWs. Refer to the How to Bring Side A into Service (page 93).

__________

Bring up the upgraded Side A
CallRouter, Logger, and
HDS/Distributor AW.

__________

Refer to the Logger Common Ground Upgrade: Side A/B
(page 87).

9. Upgrade the Side B Logger.

__________

Refer to the CallRouter Common Ground Upgrade: Side B
(page 95).

10. Upgrade Side B CallRouter.

__________

**************************************End of Central Controller
Upgrade Maintenance Window

Refer to the Distributor AW/HDS Common Ground
Upgrade (page 78).

11. Upgrade the Side B
HDS/Distributor AW and bring it
into service once the upgrade is
completed. This can begin at any
point after step 8.

__________

Refer to Administrative Workstation (AW) Upgrade
Procedures (page 67).

12. Upgrade the AWs, PGs, RMS,
and CIS components.

Refer to the Peripheral Gateway (PG) Upgrade Procedures
(page 99).

__________

Refer to the Remote Monitoring System (RMS) Upgrade
Procedures (page 123).

6) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsAction/ReferenceStep/Completed

Refer to the CIS Upgrade Procedures (page 117).

Common Ground Upgrade Checklists

Select the appropriate Common Ground checklist for your ICM/IPCC system upgrade.

Table 15: Production HDS/Distributor AW Upgraded in Parallel with the Central Controller Upgrade Maintenance Window

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this checklist MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).
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CommentsAction/ReferenceStep/Completed

Complete the applicable baseline requirements:1. Upgrade the production system to
the required baseline.

• Ensure all ICM nodes are at ICM/IPCC Release 5.0(0)
or ICM/IPCC Release 6.0(0).__________

• Ensure all ICM/IPCC nodes are running Windows
2000 SP4.

• Ensure the Logger and HDS are running SQL Server
2000 SP4.

• Ensure the CAD is at Release 4.6 or 6.0 on Windows
2000 Server SP4 and MSDE 2000 SP3a.

• Ensure the CTI OS desktops are at Version 4.7, 5.0,
5.1, or 6.0.

• Ensure CEM, CCS, CMB at Version 5.0.

• Ensure DCA is at Version 2.1.

• Ensure CCM is at Version 3.3, 4.0, or 4. 1, with the
compatible IP IVR or CVP (ISN) version.

• Ensure all ACDs are at a version compatible with
ICM/IPCC 7.0(0).

• Ensure the hardware meets BOM specifications.

• Create and configure the Active Directory
environment for ICM/IPCC.

• Run the Windows firewall configuration scripts to
enable network connectivity.

• Ensure the ICM/IPCC Support Tools Server is
upgraded to Version 2.0.

• Perform a backup of the existing servers and verify
the backups.

For additional information refer to Baseline
Requirements (page 17).

Upgrade Guide Cisco ICM/IPCC Enterprise & Hosted Editions Release 7.0(0)

160

Chapter 20: - Upgrade Checklists

Common Ground Upgrade Checklists



CommentsAction/ReferenceStep/Completed

AD considerations for upgrade:2. Create the Active Directory
environment.

• Migrating users from the old domain to the new
domain using the Domain Conversion Tool.__________

• Put the new servers in the Active Directory domain
in the appropriate ICM OU.

• Validate IP connectivity and remote access.

• If the AD domain controller is on the Logger, migrate
the domain controller roles to new non-ICM servers.

Note: Refer to "Migrating Active Directory and DNS
to a Non-ICM Server" for additional information.

• Bring up the new domain controllers on the domain
in which the ICM operates.

• Transfer any applicable flexible single master
operations (FSMO) roles.

• Demote the domain controller on the production
Logger to a member server.

For additional information refer to Domain Conversion
Tool and Active Directory (page 45).

Refer to Setting Up a Temporary ICM/IPCC AW/HDS
(page 80).

3. Set up a temporary 7.0
HDS/Distributor AW.

__________

**************************************Start of Central Controller
Upgrade Maintenance Window

Refer to Distributor AW/HDS Common Ground Upgrade
(page 78).

4. Upgrade the Side A
HDS/Distributor AW.

__________

Refer to Logger Common Ground Upgrade: Side A/B
(page 87).

5. Upgrade the Side A Logger.

__________

Refer to CallRouter Common Ground Upgrade: Side A
(page 92).

6. Upgrade the Side A CallRouter.

__________

Refer to the WebView Installation Guide7.7. Install the WebView server(s) if
not co-located on the AW/HDS.

__________

7) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsAction/ReferenceStep/Completed

None.8. Bring down the side B CallRouter,
Logger, and all distributor and Client
AWs. Refer to How to Bring Side A into Service (page 93).

None.__________

Bring up the upgraded Side A
CallRouter and Logger.

__________

Point the temporary HDS/Distributor
AW to the upgraded Side A
CallRouter and Logger.

__________

Refer to CallRouter Common Ground Upgrade: Side B
(page 95).

9. Upgrade the Side B CallRouter.

__________

Refer to Logger Common Ground Upgrade: Side A/B
(page 87).

10. Upgrade the Side B Logger.

__________

**************************************End of Central Controller Upgrade
Maintenance Window

Refer to Distributor AW/HDS Common Ground Upgrade
(page 78).

11. Upgrade the Side B
HDS/Distributor AW.

__________

None.12. Bring up the Upgraded Side A
HDS/Distributor AWs, when
available, at any point after Step 8.

__________

None.13. Bring up the Upgraded Side B
HDS/Distributor AW.

__________

Refer to Administrative Workstation (AW) Upgrade
Procedures (page 67).

14. Upgrade the AWs, PGs, RMS,
and CIS components.

Refer to Peripheral Gateway (PG) Upgrade Procedures
(page 99).

__________

Refer to Remote Monitoring System (RMS) Upgrade
Procedures (page 123).

Refer to CIS Upgrade Procedures (page 117).
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Table 16: Production HDS/Distributor AW Upgraded before the Central Controller Upgrade Maintenance Window

Warning: In order to complete an upgrade successfully, the order of upgrade as defined
in this checklist MUST be followed.

Warning: When upgrading a hosted system with multiple instances, you must upgrade
the instances in sequential order (as created).

CommentsAction/ReferenceStep/Completed

Complete the applicable baseline requirements:1. Upgrade the production system
to the required baseline.

• Ensure all ICM nodes are at ICM/IPCC Release 5.0(0)
or ICM/IPCC Release 6.0(0).__________

• Ensure all ICM/IPCC nodes are running Windows 2000
SP4.

• Ensure the Logger and HDS are running SQL Server
2000 SP4.

• Ensure the CAD is at Release 4.6 or 6.0 on Windows
2000 Server SP4 and MSDE 2000 SP3a.

• Ensure the CTI OS desktops are at Version 4.7, 5.0, 5.1,
or 6.0.

• Ensure CEM, CCS, CMB at Version 5.0.

• Ensure DCA is at Version 2.1.

• Ensure CCM is at Version 3.3, 4.0, or 4. 1, with the
compatible IP IVR or CVP (ISN) version.

• Ensure all ACDs are at a version compatible with
ICM/IPCC 7.0(0).

• Ensure the hardware meets BOM specifications.

• Create and configure the Active Directory environment
for ICM/IPCC.

• Run the Windows firewall configuration scripts to
enable network connectivity.

• Ensure the ICM/IPCC Support Tools Server is upgraded
to Version 2.0.

• Perform a backup of the existing servers and verify the
backups.

For additional information refer to Baseline Requirements
(page 17).
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CommentsAction/ReferenceStep/Completed

AD considerations for upgrade:2. Create the Active Directory
environment.

• Migrating users from the old domain to the new domain
using the Domain Conversion Tool.__________

• Put the new servers in the Active Directory domain in
the appropriate ICM OU.

• Validate IP connectivity and remote access.

• If the AD domain controller is on the Logger, migrate
the domain controller roles to new non-ICM servers.

Note: Refer to "Migrating Active Directory and DNS
to a Non-ICM Server" for additional information.

• Bring up the new domain controllers on the domain in
which the ICM operates.

• Transfer any applicable flexible single master operations
(FSMO) roles.

• Demote the domain controller on the production Logger
to a member server.

For additional information refer to Domain Conversion
Tool and Active Directory (page 45).

Refer to Setting Up a Temporary ICM/IPCC AW/HDS
(page 80).

3. Set up temporary release 5.0 or
release 6.0 HDS/Distributor AW.

__________

Refer to Distributor AW/HDS Common Ground Upgrade
(page 78).

4. Upgrade the Side A
HDS/Distributor AW.

__________

Refer to the WebView Installation Guide8.5. Install the WebView server(s) if
not co-located on the AW/HDS.

__________

**************************************Start of Central Controller
Upgrade Maintenance Window

Refer to Logger Common Ground Upgrade: Side A/B
(page 87).

6. Upgrade the Side A Logger.

__________

CallRouter Common Ground Upgrade: Side A (page 92)7. Upgrade the Side A CallRouter.

__________

8) http://www.cisco.com/univercd/cc/td/doc/product/icm/icmentpr/icm70doc/report7/index.htm
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CommentsAction/ReferenceStep/Completed

None.8. Bring down the side B
CallRouter, Logger, and all
distributor and client AWs. Refer to How to Bring Side A into Service (page 93).

__________

Bring up the upgraded Side A
CallRouter, Logger, and
HDS/Distributor AW.

__________

Refer to Logger Common Ground Upgrade: Side A/B
(page 87).

9. Upgrade the Side B Logger.

__________

Refer to CallRouter Common Ground Upgrade: Side B
(page 95).

10. Upgrade the Side B CallRouter.

__________

**************************************End of Central Controller
Upgrade Maintenance Window

Refer to Distributor AW/HDS Common Ground Upgrade
(page 78).

11. Upgrade the Side B
HDS/Distributor AW and bring it
into service once the upgrade is
completed.

__________

Refer to Administrative Workstation (AW) Upgrade
Procedures (page 67).

12. Upgrade the AWs, PGs, RMS,
and CIS components.

Refer to Peripheral Gateway (PG) Upgrade Procedures
(page 99).

__________

Refer to Remote Monitoring System (RMS) Upgrade
Procedures (page 123)

Refer to CIS Upgrade Procedures (page 117).
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Part 3: Post-upgrade Testing
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Post-Upgrade Testing

Develop a Test Plan

A test plan is utilized at various stages of the upgrade process. It is up to you to develop the
actual test cases with actual dialed numbers, labels, targets, and expected results. The key areas
in which to develop test cases follow.

Application test

The most crucial test is the ability of the system to route calls to defined peripheral targets. Side
A of the ICM system is upgraded to ICM/IPCC 7.0(0) first, then returned to service. Monitor
the ICM call routing decisions to determine if it is making the appropriate routing decisions.
The Key AWs, upgraded prior to the side B Central Controller, are used to monitor call routing.

System Integrity Tests

The remaining tests are performed to ensure proper functionality of all system components
when the ICM is running in duplex mode. Give special attention to redundancy testing.

Process Testing

Validate processes on the ICM system. For example, check the following processes for:

• RTR - all configuration data transferred from logger

• LGR - completed initialization

• AW - updateAW has completed update and waiting work
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Step 1 Ensure each software process is running according to specification.

Step 2 Check each NIC for the proper connection to the carrier (IXC) network.

Step 3 Halt and restart each process.

Redundancy Testing

Step 1 Stop each active PG to ensure that the back-up PG assumes an active state.

Step 2 Stop the active CallRouter side to ensure that the system switches to the alternate CallRouter
side without loss of functionality.

Step 3 Perform the same tests on the logger and the NIC.

Alarm Testing

Step 1 Verify your Network Operations Center (responsible for Alarm Tracker monitoring of the
system) is receiving the alarms in their tracking system.

Historical Reporting Testing

Step 1 Launch queries against the upgraded Loggers to ensure the presence and integrity of historical
call detail

WebView Reporting Testing (Optional)

Step 1 Open the commonly used WebView views.

Step 2 Examine the data presented.

Internet Script Editor Testing (Optional)

Step 1 Open the most commonly monitored ICM scripts using Internet Script Editor.

Step 2 Examine the data presented.

Set All ICM Services to Automatic Start

Step 1 Double-click the local ICM Service Control icon on each ICM component.
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Step 2 Select each ICM Service and set it to Automatic start.

Notify Stakeholders

Notify the stakeholders that the upgrade migration is complete (see Stakeholder Notification
(page 169)).

Run Post-upgrade Tests

A test plan is utilized at various stages of the upgrade process. It is up to you to develop the
actual test cases with actual dialed numbers, labels, targets, and expected results. The key areas
in which to develop test cases follow.

The key areas in which to develop test cases follow. Refer to Run Pre-upgrade tests for additional
information on the following tests:

• Application test

– Validate Scripts

• System Integrity Tests

– Process testing

– Redundancy testing

– Alarm testing

– Historical reporting testing

– WebView reporting testing (option)

– Internet Script Editor testing (option)

Note: It may be necessary to run additional tests as required due to the new ICM/IPCC release
functionality.

Validate Scripts

Step 1 Open Script Editor.

Step 2 Select Script > Validate All (or click Validate All in the tool bar).

Step 3 Observe all scripts are functioning properly. Make note of any scripts not operating properly
after the upgrade, then compare these to the list generated prior to the upgrade.
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